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Notice Every effort was made to ensure that the information in this document 
was accurate at the time of printing. However, information is subject to 
change without notice, and Viavi reserves the right to provide an 
addendum to this document with information not available at the time that 
this document was created.

Copyright © Copyright 2016 Viavi, LLC. All rights reserved. Viavi, Enabling Broad-
band and Optical Innovation, and its logo are trademarks of Viavi, LLC. 
All other trademarks and registered trademarks are the property of their 
respective owners. No part of this guide may be reproduced or trans-
mitted electronically or otherwise without written permission of the 
publisher.

Trademarks Viavi and 6000A V2 Platform are trademarks or registered trademarks of 
Viavi in the United States and/or other countries.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet 
Explorer are either trademarks or registered trademarks of Microsoft 
Corporation in the United States and/or other countries.

Netscape Navigator is a trademark or registered trademark  of Netscape 
Communications Corporation in the United States and other countries.

Specifications, terms, and conditions are subject to change without 
notice. All trademarks and registered trademarks are the property of their 
respective companies.

Ordering
information

This guide is a product of Viavi's Technical Information Development 
Department, issued as part of the User Manual. The ordering number for 
a published guide is E6000AV2M02.

WEEE Directive
Compliance

Viavi has established processes in compliance with the Waste Electrical 
and Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to your 
national regulations. In the European Union, all equipment purchased 
from Viavi after 2005-08-13 can be returned for disposal at the end of its 
useful life. Viavi will ensure that all waste equipment returned is reused, 
recycled, or disposed of in an environmentally friendly manner, and in 
compliance with all applicable national and international waste legisla-
tion.
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It is the responsibility of the equipment owner to return the equipment to 
Viavi for appropriate disposal. If the equipment was imported by a 
reseller whose name or logo is marked on the equipment, then the owner 
should return the equipment directly to the reseller.

Instructions for returning waste equipment and batteries to Viavi can be 
found in the Environmental section of Viavi’s web site at www.viavisolu-
tions.com. If you have questions concerning disposal of your equipment 
or batteries, contact Viavi’s WEEE Program Management team.
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About This Guide
The 6000A V2 Platform of Viavi provides a handhled modular platform 
designed for the construction, turn-up and maintenance of fiber 
networks.

The topics discussed in this chapter are as follows:

– “Purpose and scope” on page xviii

– “Assumptions” on page xviii

– “Technical assistance” on page xviii

– “Conventions” on page xviii
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About This Guide
Purpose and scope
Purpose and scope
The purpose of this guide is to help you successfully use the 6000A V2 
Platform features and capabilities. This guide includes task-based 
instructions that describe how to install, configure, use, and troubleshoot 
the 6000A V2 Platform. 

Additionally, this guide provides a complete description of Viavi’s 
warranty, services, and repair information, including terms and condi-
tions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users 
who want to use the 6000A V2 Platform effectively and efficiently. We are 
assuming that you have basic computer and mouse/track ball experience 
and are familiar with basic telecommunication concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest 
TAC information, go to http://www.viavisolutions.com/en/services-and-
support/support/technical-assistance.

Conventions
This guide uses naming conventions and symbols, as described in the 
following tables.

Table 1 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch.

Code and output messages 
appear in this typeface.

All results okay
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About This Guide
Conventions
Table 3 Symbol conventions

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dia-
log box 

Variables appear in this type-
face.

Type the new hostname

Book references appear in this 
typeface. 

Refer to Newton’s Telecom 
Dictionary

A vertical bar | means “or”: only 
one option can appear in a sin-
gle command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simulta-
neous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
key strokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from 
menu.

On the menu bar, click 
Start > Program Files.

Table 1 Typographical conventions (Continued)

Description Example

This symbol represents a general hazard.
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Conventions
Table 4 Safety definitions

This symbol represents a risk of electrical shock.

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging 
indicates that the equipment must not be disposed of in a land-
fill site or as municipal waste, and should be disposed of 
according to your national regulations.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.
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Chapter 1 6000A V2 Platform Overview
1

This chapter provides a general description of the 6000A V2 Platform.

Topics discussed in this chapter include the following: 

– “About the 6000A V2 Platform” on page 2

– “Main features” on page 3

– “Hard keys and indicators” on page 5
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Chapter 1 6000A V2 Platform Overview
About the 6000A V2 Platform
About the 6000A V2 Platform
The MTS/T-BERD 6000A V2 is a multiple layer test platform. It allows to 
manage Fiber Optics Modules, but also Multiple Services Application 
Modules (SDH/SONET, Ethernet and Triple Play).

The MTS/T-BERD 6000A is equipped with:

– a base pack

– a Single Fber Optic module carrier (E6100)

or a FiberOptic and Transport module carrier (E6200)

– a touchscreen

– a memory extension on option

Moreover, the MTS/T-BERD 6000A V2 is equipped with additional fans if 
a battery/MSAM pack is installed.

Fig. 1 MTS/T-BERD 6000A V2 with Module carrier

OR

FiberOptic and Transport Module Carrier

Single FiberOptic Module Carrier

Fan
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Chapter 1 6000A V2 Platform Overview
Main features
Main features
The 6000A V2 Platform is equipped with the following elements:

– One protection cover 

– 8 inch TFT color touchscreen, high visibility (optimized for outdoor 
use), 

– RJ45 plug for Ethernet interface

– Two USB 2.0 host connectors for Microscope, USB memory stick, 
mouse, keyboard...

– An audio jack to connect a headset

– A connection socket for the mains adapter providing the 19 V power 
supply and used to charge the battery.

– LED indicators for Charge, On status and Testing

– One Li-Ion battery (option)

– One high power Li-Ion battery  in option (mandatory with Transport 
applications)

– a module, interchangeable in the field: OTDR, OLP, OSA...

– Built-in Power Meter, VFL and/or Talkset (options)

– A hard disk (option)

With the 6000A V2 Platform, the user can:

– Open and/or transfer files to a PC via a USB memory stick, Blue-
tooth (option) or WIFI (option)

Fig. 2 MTS/T-BERD 6000A V2 with(out) protection cover
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Chapter 1 6000A V2 Platform Overview
Main features
– Generate pdf reports

– Open all user documentations included into the 6000A V2 Platform

– Update the 6000A V2 Platform firmware

– Remote the screen of the 6000A V2 Platform onto a PC and issue 
commands from the keyboard of the PC

– ...

Fig. 3 6000A V2 Platform - Front Panel description

Fig. 4 6000A V2 Platform Connectors - Upper view

Hard keys

 8’’ TFT Touchscreen

Hard keys

Indicators

Indicators

Direction keys

Hard keys

USB
Power Meter

VFL

RJ45

Headset jack

Talkset

SD Card
RS422/GPS

Mini USB 2.0 port

Stylus for touchscreen AC/DC input
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Hard keys and indicators
Hard keys and indicators

Front panel
hard keys

The direction keys have two principal functions:

Table 5 Hard keys description

Hardkeys Function

Main on/off switch

Starts and stops the measurement

This button calls up the results page (e.g. with OTDR 
module: reflectometry trace and table of results).

This button calls up the measurement configuration 
menu. This menu depends on the function in use.

This button calls up the file explorer. It allows to:

– choose the storage medium: internal memory, USB 
memory key...

– manage files; with facilities for classifying them in 
directories and sub-directories.

This button is used to print a measurement report or a 
screenshot from a results page in jpg, png or pdf format

Gives access to:

– selection of the different measurement or functions

– the settings of the instrument

– the help page

NOTE

All these functions, except HOME, depend on the modules used and 
the measurements made: refer to the user manuals of the corre-
sponding modules of the 6000A V2 Platform.

– on the Results page, they are used to move the cursors 
or modify the zoom factor.

– on the set-up pages, they are used to scroll through the 
menus, the central button serving to select or confirm 
the parameter chosen.
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Hard keys and indicators
Front panel
indicators

The 6000A V2 Platform is equipped with three indicators, lit into a 
different color according to the status of the equipment.

Table 6 Indicators Status

On indicator

Solid green
The instrument is operating, either on battery 
or on an external power supply.

Blinking green
The instrument is switched off but connected 
to an external power source.

Charge indicator

Solid red
The unit is connected to an external power 
source and the battery charge is in progress.

Testing indicator

 Solid red
At least one function is in measurement 
phase (for example, the laser emission pilot 
for an OTDR measurement)
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Chapter 2 Safety information
2

This chapter gives the main information on the safety conditions when 
using the 6000A V2 Platform:

– “Battery and AC/DC safety information” on page 8

– “Precautions relating to optical connections” on page 8

– “Laser Safety instructions” on page 9
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Battery and AC/DC safety information
Battery and AC/DC safety information
The Li-Ion battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent 
excessive internal pressure in the event of overcharging or expo-
sure to very high temperatures.

Battery supplied by Viavi incorporate protection means.

Do not use any mains adaptor, power cord or battery other than 
those supplied with the instrument, or supplied by Viavi as an option 
for this instrument.

If another adapter, cord or battery is used, it may damage the 6000A 
V2 Platform itself.
Using the 6000A V2 Platform with a battery other than the one 
supplied by the manufacturer of the 6000A V2 Platform may entail 
risks of fire or explosion. 

The battery may explode, leak or catch fire:

– if it is exposed to high temperature or fire

– if it is opened or dismantled.

Other basic safety precautions are as follows:

– Do not use AC/Adapter/Charger outdoors or in wet or damp loca-
tions

– Connect the AC/Adapter/Charger to the correct mains voltage, as 
indicated on the ratings label.

– Do not allow anything to rest on the power cord, and do not locate 
the product where people can walk on the power cord.

– Avoid using this product during an electrical storm. There may be a 
remote risk of electric chock from lightning.

– Do not use this product in the vicinity of a gas leak or in any explo-
sive environment.

– Do not attempt to service this product yourself, as opening or 
removing covers may expose you to dangerous, high voltage points 
and other hazards. Contact qualified service personal for all service.

Precautions relating to optical connections
– The normal operating life of an optical connector is usually of the 

order of a few hundred manipulations. It is then advisable to manip-
ulate the optical connections of the Platform as rarely as possible.
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Laser Safety instructions
– The proper operation of the instrument and its accuracy of measure-
ment are dependent on the cleanliness of the environment and the 
optical connectors as well as the care taken in its manipulation.

– The optical connectors must therefore be clean and dust-free. If the 
optical connection is not being used, protect the connections of 
6000A V2 Platform using the protective caps.

Laser Safety instructions
The provisions contained in two standards define the safety procedures 
to be observed both by users and by manufacturers when utilizing laser 
products:

– EN 60825-1: 2001 - Safety of laser products – Part 1: Classification 
of products, requirements and user guidelines. 

– FDA 21 CFR § 1040.10 - Performance standards for light-emitting 
products - Laser products.

Due to the range of possible wavelengths, power values and injection 
characteristics of a laser beam, the risks inherent in its usage vary. The 
laser classes form groups representing different safety thresholds.

Laser classes Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 

– Talkset option: Class 1

– VFL option: Class 2.

Warning labels
for the laser

classes

Due to the reduced dimensions of the optical modules, it is not possible 
to attach the required warning labels to them. In line with the provisions 
of Article 5.1 of the EN 60825-1 standard, the laser class identification 
labels are shown below:

The user must take the necessary precautions concerning the optical 
output of the instrument and follow the manufacturer’s instructions.

Ref. standard
EN 60825-1, Edition 1.2, 
2001-08

FDA21CFR§1040.10

Class 1

Class 2

CLASS 1
LASER PRODUCT

LASER RADIATION
DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT

LASER RADIATION - DO 
NOT STARE INTO BEAM 

CLASS II LASER PRODUCT

CAUTION
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Laser Safety instructions
Measurements on optical fibers are difficult to execute and the 
precision of the results obtained depends largely on the 
precautions taken by the user.
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Chapter 3 Starting up
3

This chapter describes the first steps to perform when using the 6000A 
V2 Platform.

The topics discussed in this chapter are as follows:

– “Unpacking the instrument” on page 12

– “Installing and removing a plug-in unit in the 6000A V2 Platform” on 
page 12

– “Choosing the position of the instrument on the work surface” on 
page 13

– “Charging the battery” on page 14

– “Switching the 6000A V2 Platform on and off” on page 15
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Unpacking the instrument
Unpacking the instrument
1 Remove the 6000A V2 Platform and its accessories from the 

packing case. 

2 Check that the module and accessories ordered are all there.

If any part is missing or damaged please contact your local Viavi agent.

At the equipment delivery, the following elements are available:

– the 6000A V2 Platform is assembled: module/battery pack is 
mounted onto the base pack

– the options ordered (hard disk, optical options, wifi...) are mounted 
into the equipment

– a mains adapter used for mains operation of the instrument and 
battery charging is delivered on standard.

Installing and removing a plug-in unit in the 6000A V2 Platform

Inserting a
plug-in unit into

the 6000A V2
Platform

1 Slide the plug-in into its slot.

2 When the plug-in is fully home, press firmly on the screen-printed 
face of the plug-in while tightening the clamping screws.

Make sure that the two large captive screws of the plug-in are screwed 
fully home.

NOTE

See “Installing the options” on page 139 if some options are ordered 
after the delivery of the Platform and must be mounted by customer.

The 6000A V2 Platform must be switched off and, if it is 
operating on the mains, its supply cable must be unplugged.

Fig. 5 OTDR Module installed into the 6000A V2 Platform

Captive screws 
fixing the plug-in 
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Choosing the position of the instrument on the work surface
Removing a
plug-in

1 Unscrew the two captive fixing screws of the plug-in completely (up 
to the stop).

2 Carefully slide the plug-in out of its slot.

Choosing the position of the instrument on the work surface
Depending on the conditions of use of the 6000A V2 Platform, the instru-
ment may be placed on a flat surface or held in the hand.

When used on a work surface, the 6000A V2 Platform should be 
supported on its stay, which can be set in either of two positions, 
depending on whether the user is standing or sitting.

To change the stay from “seated user” position to “standing user” posi-
tion, press both sides to slide the stay towards the upper end of its 
groove, as shown in the drawings below.

The stay is available exclusively on the Single FO Module carrier 
(reference E6100).

Fig. 6 Stay in positions for seated user and standing user

Seated user
Standing user 
(recommended)
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Charging the battery
Charging the battery

Connecting the
mains adapter

1 At the top of the 6000A V2 Platform (upper left-hand corner), lift up 
the power supply socket protector and plug in the mains adapter. 

2 Connect the adapter to the mains. 

The On/Off indicator starts to blink in green. 

Charging the
battery

On connection to the mains:

– if the user does not press ON, the battery will start the charge. 

– when the user presses the ON key, the instrument starts up and the 
battery will charge during use.

The Charge indicator is lit in solid red during charge.

Once the battery is fully charged, the Charge indicator is lit in solid green 
on the front panel.

When the Charge indicator on the front panel is blinking red, this mean 
the power supply is not compatible with the battery used. Charge is 
disabled.

Battery charge
level display

When the battery is installed in the instrument, a battery icon is displayed 
in the top right-hand corner of the screen. Example 

The most stable position for using the 6000A V2 Platform is the 
«standing» user position.

Use only the mains adapter supplied with the 6000A V2 Platform. 
The adapter for some other electronic device may appear to be 
identical, but entails a risk of damage to the 6000A V2 Platform.

It is essential to wait until charging is complete to ensure 
maximum independent operating time, which may otherwise be 
considerably reduced.

Icon Battery charge level

From 100% to 70%
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Switching the 6000A V2 Platform on and off
– When the level becomes too low, the instrument emits a beep to 
inform the user until it switches off automatically after saving the 
current configuration and measurement.

– The icon  is displayed on the upper banner to indicate the Plat-
form is connected to mains and battery is fully charged (100%).

– If the icon is displayed , this mean the Platform is connected to 
mains but battery charge is inferior to 100%.

Switching the 6000A V2 Platform on and off

Switching on
the 6000A V2

Platform

1 Press the ON/OFF key.

If the Platform is powered to mains, the battery will charge.

The On indicator pass from blinking to solid green. 

The Viavi logo appears on the screen briefly, then an autotest is 
carried out.

The equipment is ready to be used once all the applications are 
installed.

From 70% to 40%

From 40% to 10%

From 10% to 0%

Icon Battery charge level

NOTE

It is possible to switch over from battery to mains operation, or vice 
versa, without loss of data.

The module cannot be swapped when the unit is ON or AC 
powered

In the event of an unexpected mains power cut, if there is no 
battery, the current results and configuration will not be saved. 
Next time the instrument is switched on, it will return to its initial 
configuration.
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Switching the 6000A V2 Platform on and off
Switching off
the 6000A V2

Platform

While the 6000A V2 Platform is operating, press the ON/OFF button to 
switch it off.

Resetting the
6000A V2
Platform

If the 6000A V2 Platform freezes, prolonged pressure (about 4 s.) on the 
ON/OFF key will reset the instrument

NOTE

When the instrument is switched off using the ON/OFF button, current 
results and configuration are saved. Next time the ON/OFF key is 
pressed, they are recalled.
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Chapter 4 Configuring the 6000A V2 
Platform
4

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

– “Displaying the System Settings screen” on page 18

– “Defining the regional settings of the system” on page 19

– “Defining the screen parameters of the 6000A V2 Platform” on 
page 20

– “Defining the Automatic shutdown of the 6000A V2 Platform” on 
page 22
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Displaying the System Settings screen
Displaying the System Settings screen
To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

2 Press the menu key System Settings to open the System 
Settings screen.

Fig. 7 Home page

Fig. 8 System Settings page

see "Installing a new 
version of the software" 
page 144

see “Creating a 
screenshot” page 83 
and "Creating a 
report" page 85

see “Transferring the 
6000A V2 Platform 
Interface” on page 63

see “Sending files by 
mail” page 81 and 
“Transferring files via 
Bluetooth” page 121
18 User Manual 76100000200 Rev. 001



Chapter 4 Configuring the 6000A V2 Platform
Defining the regional settings of the system
Defining the regional settings of the system
When the 6000A V2 Platform is delivered, it is automatically configured 
with the System Settings  set by default in factory, especially the 
language and date/time (Language: English / Date format: dd/mm/yyy / 
Time format: 24 hours clock).

To modify the regional parameters in the System Settings page:

1 Click on Language and select the language to be used for the 
equipment.

2 Click on Date and enter the current date, using the numeric keypad 
displayed with the menu key Edit Number.

3 Click on Time and enter the current time, using the numeric keypad 
displayed with the menu key Edit Number.

The date and time are displayed on the upper right side of the 
screen.

or

Select Net Time parameter and configure date and time according 
to a network (see “Net Time Synchronization” on page 19).

4 Click on Date Time Format and configure the following parameters:

– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour 
clock.

5 Once all parameters have been defined, press Exit menu key to exit 
the System Settings page.

Net Time Synchronization

This parameter allows to configure the date and time of the Platform 
according to a network.

– Dynamic Mode: the time is synchronized according to the local 
network.

The two lines Server Name are displayed but cannot be modified.

– Static Mode: in this case, the time is synchronized to the network 
server which is defined in the two following parameters.

On the parameter Address Type, select if the address of the server 
which will be used for synchronisation is entered via its IP Address 
or via the Server Name.

If IP Address is selected, enter one or two server addresses in the 
following parameters. During synchronization, the first address will 
always be used, but if a fail occurs, the second one will be used.
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Defining the screen parameters of the 6000A V2 Platform
If Server Name is selected, enter the name of the server, and if 
necessary a name for second server. During synchronization, the 
first server name will always be used, but if a fail occurs, the second 
one will be used.

If Dynamic or Static mode is defined, the current Date and Time cannot 
be modified (parameters are greyed) and the icon  displays on the 
upper banner, between the hour and the date .

– None: the time is not synchronized according to a server. In this 
case, the user can reset date and time himslef, using the fields Date 
and Time.

Defining the screen parameters of the 6000A V2 Platform
In the System Settings page, the following parameters can be defined:

Backlight 1 Click on Backlight 

2 Define the backlight level of the screen, using the left and right 
direction keys, or clicking on Edit Number softkey and using the 
keypad displayed.

– Min backlight level: -5

– Max backlight level: +5

Contrast 1 Click on Contrast

2 Select the type of environment into which the instrument is used:

– Indoor: to be selected when the instrument is used inside (see 
Figure 8 on page 18)

– Outdoor: to be selected in order to optimize the readability of 
the screen for an outside use.

If the network configuration is modified, synchronization may be 
lost.

If the 6000A V2 Platform is operating on battery, it is advisable to 
choose a minimum lighting level, acceptable for the user, to keep 
endurance as long as possible.
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Chapter 4 Configuring the 6000A V2 Platform
Defining the Audio parameters of the 6000A V2 Platform
Screen Saver Click on Screen Saver if you wish to activate a screen saver to the equip-
ment, to extend the life of the battery, in case the 6000A V2 Platform is 
not used for some time.

Instead of the normal screen, a small animated picture of the 6000A V2 
Platform is displayed on the blackened screen. 

To configure the screen saver:

1 Click on Delay and select the time of inactivity 
before the screen saver starts: 60s, 3 min, 5 min.

The parameter No deactivates the screen saver 
function.

Defining the Audio parameters of the 6000A V2 Platform
In the Audio box of the System Settings screen, you can configure the 
audio parameters according you are using a headset with the 6000A V2 
Platform.

1 Adjust the volume on the line Hands-free Volume using the left and 
right direction keys, or the Numeric keypad (displayed with the 
softkey Edit Number)

– Min volume for Hands-free function: 0

– Max volume for Hands-free function: 100

Fig. 9 Example of outdoor contrast
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Defining the Automatic shutdown of the 6000A V2 Platform
2 If a headset is used, adjust the volume on the line Headset Volume, 
using the left and right direction keys, or the Numeric keypad 
(displayed with the softkey Edit Number):

– Min volume for Headset function: 0

– Max volume for Headset function: 100

Defining the Automatic shutdown of the 6000A V2 Platform
The automatic shutdown function switches off the 6000A V2 Platform 
automatically if no operation has been performed and no key actuated for 
a period selected from this menu. Work in progress is automatically 
saved.

1 In the Utility box, click on Auto off parameter.

2 Choose a time after which the 6000A V2 Platform will be switched 
off automatically, if no action has been done for that period: 5, 10 or 
30 minutes.

Select No if the 6000A V2 Platform must not be switched off, even if there 
is inactivity on the equipment.

The function for automatically switching off the 6000A V2 
Platform is available only on battery operation, to save the 
battery.
22 User Manual 76100000200 Rev. 001



Chapter 5 Power meter, VFL (Visual 
Fault Locator) & Talkset
5

A variety of built-in optical options are available when ordering. See 
references in Chapter 15 “Options and accessories” page 131, for 
details.

The topics discussed in this chapter are as follows:

– “Connection to the power meter, VFL and Talkset” on page 24

– “Using the Power meter” on page 24

– “VFL Function” on page 29

– “Storing and reloading results” on page 30

– “Talkset/Datalink Function” on page 31

– “Remote screen function via Talkset” on page 33
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Connection to the power meter, VFL and Talkset

The type of optical connector used for the power meter is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.)

Using the Power meter
The power meter function is an option chosen at the time of order and 
incorporated into the 6000A V2 Platform in the factory.

To activate the function:

1 Press the HOME button

2 Activate the power meter icon of the Platform  . 

The effect of this action will to be to bring the power meter into use 
and to display the Results page for Power Meter.

Fig. 10 Optical connectors

Power meter optical 
connection

VFL Talkset optical 
connection

Accuracy of measurements

A high degree of accuracy is often required. It is then necessary to 
perform a preliminary calibration without the fiber under test to elimi-
nate the losses due to connections as far as this is possible. To do 
this, use the «Reference Value» function.
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Configuring the
power meter

Configuring
measurement

parameters

The measurement parameters can be accessed with the SETUP key.

Wavelength Selecting wavelength:
- Auto: the wavelength of the input signal will be
automatically detected and selected to perform
the measurement:
850, 980, 1300, 1310, 1420, 1450, 1480, 1490,
1510, 1550, 1625 or 1650 nm: measurement
performed at specified wavelength.
- User: choice of wavelength on the next line

User choice (if the User option was selected in the Lambda
line) enter the wavelength between 800 and
1650 nm, using the numeric keypad, displayed
via the Edit Value key..

Beep on Modulation Select if a sound must be heard when a
modulation occurs (Yes / No)

Unit Unit of power displayed:

- Watts, dBm for displaying absolute power

- dB for displaying a result relative to a reference
(link loss)

Reference level Select the reference value for the wavelength
selected. First select the wavelength, then press
the > key to access choice of the value
(+XXX.XX).

This reference is also automatically available, in
the Results page, using the Set as Reference
key.

Fig. 11 Configuration of power measurement
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Attenuator compensation
Choice of level to be applied to the wavelength
chosen for measurement to compensate for the
loss due to the external attenuator (+XX.XX dB).
First use the direction keys to choose the
wavelength, then press > to access choice of
value.

Configuring the
alarm parameters

of the power meter

Alarm Activation of the Alarm function : any result below
the lower threshold or above the upper threshold
will be displayed in red on the Results page.

Min and max thresholds

Choice of lower and upper thresholds for each
available wavelength, from -60 to +40 dBm.

Display of
results and
commands

The results page called up by the RESULTS button, gives the information 
relating to the measurement in progress, results previously saved and 
the commands available for measurement and saving.

Result of the
measurement in

progress

The power measured by the power meter is displayed in large charac-
ters, in the units selected in the SETUP menu, together with:

– the mode of transmission of the signal measured: continuous (CW) 
or modulated to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

– the wavelength of the signal measured. 

– the reference level expressed in dB.

– the level of Attenuation Compensation.

NOTE

To copy a Reference Level or a Attenuator Compensator on all wave-
lengths, select the reference wavelength and click on Update for All 
Wavel..

NOTE

To copy one value of the Lower or/and Upper threshold for all wave-
lengths, select the reference value and click on Update for All 
Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.
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Table of results For one and the same fiber, the power meter displays a table of 9 results 
corresponding to the different possible wavelengths. The first 4 results 
are displayed on the screen; to scroll through the other results, use the 
direction key . The table shows the power measured in dBm, the rela-
tive power (in dB) and the reference level in dBm (if units = dB), together 
with the mode.

– A measurement result is displayed in the table when the Keep 
Result softkey is pressed. 

– The Clear Table softkey orders deletion of all the results displayed 
in the table. 

– If the Alarm function has been activated, any result that exceeds the 
selected thresholds appears in red in the table. Otherwise, results 
are shown in the table in green.

– When the instrument is switched off, results present in the table are 
saved.

Commands of the
power meter
parameters

When the Powermeter function is selected, the following softkeys are 
available on the results page:

The different configuration buttons are displayed:

– Wavelength selection of the wavelength

– Unit choice of the unit

– Zero Adjustment of the Zero value when the power meter’s 
optical input is closed with a plug (a validation is 
required).

On the results page, the following actions are available:

Fig. 12 Results and commands of the power meter

Results
of  the
power meter
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– Standard Reference Selects the current result as reference value 
to measure the attenuation of a link. This 
reference is displayed under the measure-
ment result until a new reference value is 
chosen.

– Keep Result Saves the result on the corresponding line 
of the table.

– Clear Table Deletes all the results recorded in the table.

If the Source function is selected (on an OTDR module, either on this 
Platform or on another one), the Power meter results page is different:

– The Wavelength, Unit and Zero menu keys are accessible via the 
menu key Power Config.

– The Power Ref. menu key allows to reach the Standard Ref menu 
key. It also allows to reach the Jumper Ref menu key if Power 
meter function is associated with OTDR Source function onto 
another unit (see 8100 Module User Manual).

Performing a
measurement

The power meter is started up as soon as the function  is acti-
vated in the HOME menu.

Power
measurement

1 Connect the light source to be tested to the rear connector (see 
"Connection to the power meter, VFL and Talkset" page 24).

2 In the SETUP menu, choose the units dBm, dB or Watts.

3 Press the START/STOP key to start the measurement. 

The result will appear in the results page and can be memorized in 
the table (see "Table of results" page 27).

4 Press the START/STOP key to stop the measurement.

Optical link loss Setting the zero value of the power meter

Power measurement is automatically updated in consequence. The 
value «<-60 dB» is displayed when the laser is switched off and if the 
source output is looped on to the power meter input.

It is important to set the zero of the power meter before making any 
measurements where accuracy is required, as the noise from the ger-
manium photodiode fluctuates over time and with variations in tem-
perature.
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1 Fix the plug over the optical input of the power meter so that no light 
can reach the photodiode of the power meter. If the zero adjustment 
is made without this plug, an error message may be displayed, as 
the photodiode will detect too much light.

2 In the Results page, press the (Powermeter Config. >) Zero soft 
key and validate.

Carrying out the reference measurement

1 Fix the adapter corresponding to the jumper to the optical connector 
of the power meter.

2 Connect the jumper between the input of the power meter and the 
output of the source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power 
meter.

4 Press the (Pow Reference >) Standard Ref soft keys to save the 
result displayed as reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the 
measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be 
tested between the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the 
optical loss of the link tested. It can be displayed in the table (see 
"Table of results" page 27).

VFL Function

VFL connector The type of optical connector used for the VFL source is UPP (Universal 
Push Pull), which is compatible with all diameter 2.5 mm connectors (FC, 
SC, ST, DIN, E2000, etc.).
See Figure 10 on page 24 to visualize the VFL connector.

Visual Fault
Locator

function (VFL)

This function is used to emit a red light signal of frequency 1 Hz or in 
continuous mode into a fiber to detect any defects in the dead zone of the 
reflectometer, or to identify it. 
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This function is suitable for short fibers (length < 5 km) or the first few 
metres of a long fiber.

To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and  activate the VFL .

The icons  display on the upper banner of the screen.

The signal mode (1Hz or CW) of the VFL can be modified in the System 
Settings page, in Utility > VFL Mode parameter.

Storing and reloading results

File Setup Click on the button FILE to access the File setup. See the chapter «File 
management» in the user manual «8100 modules series» for a complete 
description of all parameters, options and description of the explorer.

Storing results In order to save the results of a measurement, click on FILE and select 
Store trace. Two files are being saved :

– The first file is used with the 6000A V2 Platform and allows to 
retrieve all measurement results. It is saved with the extension 
«.Lts».

– The second file is a ASCII file using tabulations to separate values. 
It is saved with the extension «.txt» and can be opened by the 
6000A V2 Platform. It has been designed to be used with a spread-
sheet program on a PC where it allows to retrieve all measurement 
results and format them in a nice customized table. 

Loading results In order to load the results of a measurement, select a file  with the 
extension «.Lts» in the file explorer (see the chapter «File management» 
in the user manual for «8100 modules series»), click on Load. 
The LTS tab is displayed with the loaded results in the table

NOTE

Identification is facilitated by the blinking of light in the fiber.
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Talkset/Datalink Function
The option enables two operators at opposite ends of an optical  link:

– To communicate along the fiber.

– To transfer data along the fiber. 

Each end of the optical link must be provided with a 6000A V2 Platform 
equipped with the Talkset option.

Talkset
configuration

The talkset configuration is set in the System Settings screen, in the 
Audio box (see "Adjusting volume level" page 32)

Connections At each end of the fiber: 

1 Connect the fiber to the Talkset port of the 6000A V2 Platform, either 
directly or through jumpers.

The Talkset connector is set with a FC adapter by default.

2 A headset (with earphones and a microphone) supplied with the 
option may also be plugged into the 6000A V2 Audio jack.

n
NOTE

It is possible to use the talkset of the 6000A V2 Platform and to carry 
out measurements at the same time, on a different fiber.

NOTE

It is possible to use the Data transfer feature while using the optical 
telephone of the 6000A V2 Platform. Nevertheless, the data transfer 
speed will be slightly decreased.

Fig. 13 Installation for Talkset use
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Establishing
communication

On the caller 6000A V2 Platform, press the HOME button, then validate 
the desired function:

– Talkset (Optical Telephone): used to communicate via the 
fiber.

– Datalink : used to transfer data along the fiber.

If the remote instrument is ready to receive (on standby), the Talkset icon 
turns yellow, beeps are emitted, and

– the icon  appears at the top of the screen: telephone communi-
cation can now take place. 

– the icon  appears at the top of the screen: data transfer can now 
take place.

If the remote instrument is not ready to receive, the Talkset icon does not 
change color and a message is emitted.

Adjusting
volume level

The sound is transmitted to the earphones of the headset and, if this 
function has been activated, to the speaker in the 6000A V2 Platform 
base. To activate the base loudspeaker and adjust the volume:

1 Press the HOME key.

2 Press System Settings key to reach the System Settings page.

3 In the Audio box, select Channele and define the communication 
settings: Hands-free / Headset / Auto.

NOTE

Data transfer uses the same fiber as the optical telephone

NOTE

The talkset icon is displayed on the top banner as long as communi-
cation remains established, letting the user know that the connection 
is working.
When communication is established, the headset is automatically 
enabled if plugged in. However, the loud speaker must be correctly 
configured in the setup menu to work accordingly 

NOTE

Data transfer varies according to the type of application you use. For 
Fiber Optics for example, you can use the explorer. The distant 6000A 
V2 Platform will be shown just like a disk and all file and directory fea-
tures can be used from and to that disk.
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4 According to previous configuration, adjust Hands-free Volume 
and/or Headset Volume (from 0 to 100). 

Disconnection When communication is over, deactivate the Talkset/Datalink function 
on one of the 6000A V2 Platform. This deactivation can be done by either 
6000A V2 Platform.
Then, the fiber used for Talkset can be disconnected safely.

Remote screen function via Talkset
This enables an operator at one end of an optical link to take control over 
another 6000A V2 Platform connected at the other end, using the fiber.

VNC configuration

Before it can be remote-controlled, the 6000A V2 Platform must be 
configured as explained in “Remote Screen” on page 64.

Connections

At each end of the fiber (see Figure 13 on page 31): connect the fiber to 
the Talkset port of the 6000A V2 Platform, either directly or through 
jumpers.

Remote screen via VNC is done via the data transfer feature, and on the 
same fiber as the optical telephone.

Establishing communication

On the caller 6000A V2 Platform, press the HOME button, then select and 
confirm the Talkset option:

1 If the remote instrument is ready to receive (on standby), the Data 
icon turns orange, beeps are emitted, and the icon  appears at 
the top of the screen: data transfer can now take place. 

If the remote instrument is not ready to receive, the Data icon does 
not change color and a message is emitted.

2 Click next on Expert tools, Remote Display, and on Switch to 
remote screen. 

NOTE

Each end of the optical link must be provided with a 6000A V2 Plat-
form equipped with the Talkset option.
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Your screen is now fully replaced by the distant screen, and every-
thing you do on your 6000A V2 Platform is in fact done on the 
distant 6000A V2 Platform.

An icon  appears in the top banner of the 6000A V2 Platform. 

End of a VNC session

In order to end a VNC session, you can:

1 Return to the menu Expert tools > Remote Display and click on 
Return to local screen. (Recommended solution)

or

Deactivate the data function on either 6000A V2 Platform 
connected.

or

Set Remote screen to off (see “Remote Screen” on page 64)

2 Disconnect the fiber

A slight normal color degradation may be seen on the 6000A V2 
Platform controlling a distant instrument. 

NOTE

The VNC icon in the top banner of the screen lets you know at all 
times whether you are in a VNC session or not.
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6

The scope function is a hot-plug feature enabled directly when inserting 
a Viavi scope supplied as an accessory (see "References of accesso-
ries" page 134).

The topics discussed in this chapter are as follows:

– "Scope feature" page 36

– "Installation of tips" page 36

– "Configuring the P5000i Scope" page 37

– "Starting up with the scope" page 41

– "Launching a test of the connector and fiber end-face" page 42

– "File menu" page 46
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Scope feature

Overview This feature enables you to verify that your optical connectors are in 
perfect shape and very clean condition.

The P5000i Digital Probe Microscope is a portable handheld microscope 
used to view and inspect both the bulkhead (female) and patch cord 
(male) sides of fiber connectors as well as other optical devices, such as 
transceivers.

The P5000i requires an FBPT inspection tip and is connected to the 
6000A V2 Platform with a USB 2.0 connector.

Installation of
tips

The Pass/Fail analysis function on the 6000A V2 Platform can only be 
used with certain inspection tips mounted on the P5000i.

Seven tips, patchcords and bulkheads types, are delivered with the 
Videoscope Kit (EDFSCOPE5KI) but many others can be used.

Fig. 14 P5000i Probe components

QuickcaptureTM button
Instantly captures (and analyzes) fiber image

Focus Control

Latch lock
Barrel assembly

USB 2.0 
connector

6 FT COIL Cable

Inspection tip

Magnification Control

Before using the P5000/P5000i scope, make sure the Bluetooth 
option has not been activated, even once, after the start of the 
MTS/ T-BERD 6000A V2. If it has been activated, stop and restart 
the equipment before using the P5000/P5000i Scope.
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Configuring the P5000i Scope

Scope
connection

1 Plug in your Viavi scope into a USB port from the 6000A V2 Plat-
form.

2 Push the button SYSTEM

3  Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while others are selected (e.g. OTDR).

Configuring the
Scope

1 Press SETUP key to configure the test.

The following screen displays:

Test Profile

On the line Profile, select the Profile which will be used for the test of 
fiber connector:

– SM_UPC: Pass/Fail criteria for single-mode UPC connectors from 
IEC 61300-3-35 standard.

– SM_APC: Pass/Fail criteria for single-mode APC connectors from 
IEC 61300-3-35 standard.

– SM_PC: Pass/Fail criteria for single-mode PC connectors from IEC 
61300-3-35 standard.

– MM_: Pass/Fail criteria for multimode connectors from IEC 61300-3-
35 standard.

Profiles contain the analysis parameters by which Pass/Fail criteria are 
determined.

Fig. 15 P5000i Scope Setup
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Once the line is selected, you can also add a new profile, clicking on the 
Add Button (see "Adding a new profile" page 40).

Tip

On the line Tip, select the tip set onto the scope to connect fiber for 
inspection.

Capture button (only with P5000i)

This parameter allows to select the action of the Quick Capture button 
onto the Scope (see Figure 14 on page 36):

Freeze & Test pressing the button will automatically perform a
test of fiber and freeze the result

Freeze image pressing the button onto the Scope will
automatically freeze the live image.

Auto Center (only with P5000i)

This parameter allows to select if the scope image must be centered on 
screen (select Yes) or not (select No).

File parameters The File menu allows to enter a file name for saving scope test results.

On the line Filenaming, use the edition keypad, which will display by 
clicking on the right arrow key, to enter a specific name for the file. You 
can enter manually a name and/or use pre-defined parameters (Fiber Id, 
Cable Id, Locations...).

To add a logo to a report generated from test results, select Logo param-
eter and press right direction key to display the file explorer page and 
select the image which will be used as logo on the report page (see 
“Generating a report” on page 46).

Click on menu key Load to validate the selection. The screen returns to 
configuration page and displays the file path in the Logo parameter.

Fig. 16 Edition keypad for naming scope file

Predefined 
parameters for 
naming files
38 User Manual 76100000200 Rev. 001



Chapter 6 Scope
Configuring the P5000i Scope
Fiber The Fiber box allows to configure the fiber plugged to the scope.

On the line Fiber Id, enter a name for the fiber using the edition menu 
displayed via the right direction key.

On the line Fiber Number, use the numeric keypad, which will display by 
clicking on the right arrow key, to enter the fiber number.

On the line Change fiber Nbr, select if the fiber number must be modified 
after each results saving:

No: the fiber number is not modified at each saving

Increment; the fiber number is automatically incremented at 
each results saving

Decrement: the fiber number is automatically decremented at 
each results saving.

Link Description The information entered in the Link Description window concern the 
editing and/or the modifications of the cable and fiber parameters.

– Cable Id: This parameter allows to enter an identification of the 
cable, using the Edition menu.

– Direction: The direction shows if the acquisition has been made 
from the origin to the extremity (A->B) or from the extremity to the 
origin (B->A). Changing direction makes it possible, when different 
extremities are handled, to see the parameters of the fiber for the 
other extremity.

– Location A: The name of the Location A of the link may be entered 
here.

– Location B: The name of the Location B of the link may be entered 
here

– Company: Allows to enter the name of the company carrying out 
the test.

– Operator: Use the right arrow key to enter the name of the operator 
carrying out the test.

Press Exit to return to the Results screen of the scope.

NOTE

All parameters of the Link Description box will appear in the pdf 
report generated from a test results page. See "Generating a report" 
page 46.
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Adding a new
profile

Once the Setup screen of the scope is displayed, you can add a specific 
profile which will be used for the test.

The profile must be created via FiberChek2TM, and stored on one 
storage media of the MTS/T-BERD 6000A V2 (disk, hard disk or USB 
memory stick).

1 On the Setup screen, select Profile and press Add key.

2 On the explorer, select the file which will be used as profile (icon 
 ; extension: .PRO)

3 Press Load. 

Once loaded, the display goes back automatically to Setup screen.

4 Select the profile just loaded.

Removing a profile

1 In the Profile list, select the profile to be deleted.

2 Press Remove key., then Exit.

About page On the Setup screen, the softkey About, on the right of the screen, 
allows to display information on scope and current test result displayed 
(in Full Screen mode or mosaic mode - see “Mosaic Mode” on page 44).

1 Press About softkey to display a page as the following one:

Fig. 17 About page

Information on 
scope

Information on 
active test result
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Starting up with the scope
Once the FiberScope icon is validated:

1 Press RESULTS hard key

Use the Focus Control button onto the P5000i scope (see Figure 14 on 
page 36) to adjust the image quality and sharpness.

Freeze mode Once the image is acceptable, you may freeze the picture. This feature 
allows to store in memory the resulting picture.

Fig. 18 Example of the result using the P5000i scope

Focus level for 
image sharpness

NOTE

To switch from Scope page to FO results page and vice-versa, press 
the RESULTS hard key for about 2 seconds (a beep is emitted).

Freezing a scope result does not store the picture in a file (see "File 
menu" page 46). The result will be lost if the instrument is shut off, or if 
more than 3 pictures are frozen (see "Mosaic Mode" page 44).

NOTE

The button set on the lead, or the QuickCapture™ on the P5000 
allows to freeze the picture, and to launch a test (according to config-
uration in Setup page - see “Configuring the Scope” on page 37).
User Manual 76100000200 Rev. 001 41



Chapter 6 Scope
Launching a test of the connector and fiber end-face
High Mag. / Low
Mag.

The High Mag./Low Mag. menu key allows to switch the display from 
High to Low magnification and vice-versa.
This function is also available pressing the button directly on the P5000i 
(see Figure 14 on page 36). 

Camera mode If you are in Freeze mode, or in Mosaic mode, with a picture selected 
(see “Mosaic Mode” on page 44), press Camera menu key to return to 
live camera picture.

Launching a test of the connector and fiber end-face

Launching a
test of the

connector and
fiber end-face

Once the display is correctly adjusted (magnification, sharpness...), a 
test of fiber connector can be launched.

To launch the test:

1 Press Test key to launch the test of plugged fiber connector.

The test is completed:

– once the Led Testing is no more lit in red

– once the icon  is no more displayed on the upper banner

– once a screen as the following one displays:

Use the focus control to adjust the focus of the image

NOTE

To configure the Pass/Fail critera, refer to “Configuring the Scope” on 
page 37.
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A summary of test results is displayed on the right, upper part of the 
screen.

– Zone A: represents the Core zone: it is 
the area surrounding the core

– Zone B: represents the Cladding zone. It 
surrounds the majority of the fiber clad-
ding.

– Zone C: represents the Epoxy ring.

– Zone D: represents the Ferrule/Contact 
zone: it identifies a portion of the ferrule 
near and around the fiber

Overlay The Overlay key allows, when selected, to display the limits of each zone 
and to display with colors the defaults on the image.

When the key is unselected, the zones and defaults are not graphically 
identified.

This function is also available in Mosaic Mode (see “Mosaic Mode” on 
page 44).

Fig. 19 Test results

Test result in 
High mag.

Summary of 
Test results

Zone C

Zone B

Zone A

Zone D

NOTE

To return to a Live Camera image, press Live key; or press Full Scr./
Mosaic key to view both live image and test result.

In Mosaic mode (see "Mosaic Mode" page 44), the result of the test 
only displays Pass or Fail information; the status of each zone is dis-
played only in full screen mode.
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Mosaic Mode It is possible to display only one picture in full screen (640 * 390 pixels) 
or up to four pictures (320*180 pixels each, including the live camera 
picture) in mosaic mode. Use the key Full scr./Mosaic to switch from 
one mode to another.

– You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The toolbar on the right varies according to which picture is selected 
(camera, or static scope picture):

Picture selected: Live 

Test Allows to launch a (new) test of the connector
(see  “Launching a test of the connector and fiber
end-face” on page 42) 

Freeze Allows to freeze the live image and to save it later
on the disk. Once this key is pressed, the freeze
image is automatically set on Position 2. 

Overlay Allows to display/hide the limits of each zone and
the detected defaults on image from a scope test
result (see “Overlay” on page 43).

Fig. 20 Mosaic mode

Position 1 :
Live camera

Position 2: Snapshot saved 
on disk : connector cleaned

Position 3 : 
Connector before 
being cleaned

Position 4 : JPEG image

Selected picture
Menu keys when Live 
picture is selected

If all positions were taken, the picture that was once at the fourth posi-
tion is unloaded from memory. Frozen pictures are lost, unless they 
were saved on the internal memory.
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High mag./Low mag. Allows to switch all the images from high to low
magnification and vice-versa. This key is not
available with jpg files other than those resulting
from scope application.

Picture selected: Image

Save Allows to save the selected picture in
the directory Scope, in the disk of the
Platofrm. Press Save key, enter a
name for the jpg file and validate. This
key is not available with jpg files other
than those resulting from scope
application.

Comment Allows to add a comment to the
selected picture (see “High Mag. / Low
Mag.” on page 42)

Overlay Allows to display or hide the limits of
each zone and the defaults on image
from a test result (see “Overlay” on
page 43). This key does not work on
jpg image which do not result from
scope application.

High mag./Low mag. Allows to switch all the images from high to low
magnification and vice-versa. This key is not
available with jpg files other than those resulting
from scope application.

Adding a comment

A key Comment allows you to enter/modify a comment to your picture if 
necessary. This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acqui-
sition (where the picture was frozen).

Loading a
picture

It is possible to retrieve and load a picture stored in the Scope directory 
and display it in the Scope page.

1 Press the FILE button.

2 Select Explorer. 

3 Select the JPEG file to be loaded via the Explorer

NOTE

Both the comment and the date will be saved with the picture.
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File menu
4 Click on Load

Recognized pictures are images resulting from the Scope option and 
saved on disk via the 6000A V2 Platform.

Even though the JPG editor of the Scope function has been designed to 
display Scope pictures in black & white, it is also possible to open any 
JPG valid file and display in color the corresponding picture. That picture 
is enlarged or shrunk to the size of the display (full screen or mosaic, 
see."Mosaic Mode" page 44).

File menu

Saving the test
result in a jpg

file

Once the test has been performed, and the result is displayed on the 
6000A V2 Platform screen:

1 Press FILE key

2 Click on Save key to save a jpg file of the test result on the disk of 
the 6000A V2 Platform.

3 On the edition keypad, enter the name of the jpg file

4 Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope 
(icon ).

Generating a
report

1 Check the correct test result is selected (framed in green in mosaic 
mode).

2 Press the FILE button, then the Report key

3 On the edition keypad, enter the name of the pdf file and press 
ENTER.

The report generation is completed once the icon  is no more 
displayed on the upper banner.

Some pictures resulting from the Scope option may appear 
nevertheless unrecognized, if they have been stored with a 
different Scope application, or if the JPG file has been opened 
and modified under another JPG editor.

NOTE

The pdf report will be saved on the disk, in the directory Scope.
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File menu
Display of the report

Once the report has been generated:

1 Press FILE hard key

2 On the right menu keys, press Load soft key.

3 In the File Explorer, select the pdf report just created.

4 Press Load.

Fig. 21 PDF report

Logo, company & parame-
ters selected in the Setup 
page (see “Link Descrip-
tion” on page 39)
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Chapter 7 Applications
7

Several desktop applications are provided to you, thanks to the integra-
tion of free software released under the free licences (GPL, LGPL, BSB 
or other). Their purpose is to bring more functionality to the 6000A V2 
Platform. Viavi doesn’t provide any warranty or support regarding 
these free software.

To access desktop applications, press the button SYSTEM, and the soft 
key App’s.

The topics discussed in this chapter are as follows:

– "PDF viewer" page 50

– "Text Editor" page 51

– "Web browser" page 53

– "Calculator" page 57

– "File Explorer" page 57
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PDF viewer
PDF viewer

Opening a PDF
document

The simplest way to open a pdf file is to press FILE. Select Explorer, look 
for your file and then select Load >Confirm Load to load the corre-
sponding file. The file opens automatically in the PDF viewer.

Another way used to open a pdf document is to press SYSTEM > App’s 
and select the PDF Reader icon. 

The PDF Reader opens but without document. To open a PDF 
document, click on the icon , or press FILE hard key, and select 
a document in the file explorer dialog box.

Interacting with
a PDF

document

Once your document is open, you may browse through different pages 
very quickly, zoom to a particular level, rotate the page... All these 
features are available via buttons on the screen. 

Fig. 22 PDF Viewer Graphical User Interface

Display the current page #

Go to 10 pages less

Go to previous page

Go to next page

Rotate the page

Go to 10 pages more

Change zoom level Open file

Exit PDF viewer

NOTE

You may scroll in all directions using the direction keys of the 6000A 
V2 Platform or of an external keyboard, or by dragging the scroll bars 
with touchscreen or mouse.
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Text Editor
Text Editor
The Text Editor application allows to enter text on the 6000A V2 Platform 
and save it into a txt file

Text Editor
page

To open the Text editor:

1 In the Home page, press the App’s key

2 In the Application screen, select the icon Text Editor.

The Text Editor page opens

Once the text editor is open, enter text using the method you wish:

– Enter text using an external keyboard which is connected to the 
6000A V2 Platform via the USB port or using an external keyboard 
of a PC connected to the Platform.

or

– Enter text using the keyboard of the Application

a Select Keyboard on the key 

A keyboard is displayed  on the lower part of the screen

Fig. 23 Text Editor application
User Manual 76100000200 Rev. 001 51



Chapter 7 Applications
Text Editor
b Use the arrow keys or the touchscreen to enter the text.

or

– Enter manually the text using touch screen.

a Select Writing on the key 

b Write the letter manually, using the stylus for touch screen

You can click on Train, in order to draw each character on its cell. 
This allow to store the characters with your writing characteristics, in 
order to get the good letters when writing with the stylus.=

Saving the text
in a file

Once the text is entered, you can save it in a file onto the 6000A V2 Plat-
form.

1 Click on File > Save or Save as...

2 In the dialog box, select the folder in which the file must be saved

3 Enter a name for the file with the file extension (.txt or .csv if it must 
be opened with the 6000A V2 Platform).

Fig. 24 Keyboard of the Text Editor
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Web browser
4 Click on Ok to validate

The file is saved and still opened

– You can modify it and click on Save at any time

– If you modify the file and click on Save as....you can choose another 
folder and/or another name

Press  to exit the text editor and go back to the Applications page.

Press HOME to go back to the Home page, and keep the application 
active.

Web browser

Configuring the
Web access

Before using the Web Browser onto the 6000A V2 Platform, check/
modify the proxy configuration in the System Settings page:

1 On the Home page, press System Settings menu key

2 Select Use proxy parameter in the I/O Interfaces box

– If Manual is selected, enter the Proxy Address using the edition 
keypad

– If Auto is selected, enter the Pac Address using the edition keypad.

Starting the
web browser

To access this application, on the Home page click on the soft key App’s.

In the Application screen, activate Web Browser icon .

The web browser is launched.

Fig. 25 Save file

Select the folder

Enter file name

Save the file
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Web browser
Opening an
internet page

Once the Web Browser is displayed, you must enter the internet address.

1 Set the cursor in the address bar:

a Use the mouse connected via USB port on the 6000A V2 Plat-
form or the mouse of the PC if the screen is deported via VNC 
application on the PC.

b Click on the softkey Mouse  so that it becomes . 

This allows to move the cursor toward the address bar, and to 
turn to cursor.

2 Once the cursor set onto the address bar, enter the address:

a Using a keyboard connected to the 6000A V2 Platform USB port 
or the keyboard of the PC with a deport of the screen via VNC, 
enter the entire address of the site to be opened.

b If none keyboard is available, click on Keyboard  to display 
the virtual keyboard and enter the address using touchscreen.

3 Push Enter to validate.

The page opens

If an error message is displayed in place of the internet page, verify 
the address you typed, or check the Web configuration (see "Config-
uring the Web access" page 53).

Fig. 26 Web Browser page
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Web browser
Navigation into
the Web
Browser

Once the Web Browser is open,  push the key   to display on the 
right of the screen, the buttons used to navigate.

Using the
bookmarks

Once a page is opened, you can apply it a bookmark, in order to get a 
shortcut toward this page.

Creating
bookmarks

Once the internet page for which a bookmark must be created is opened:

1 Click on  to open the dialog box for bookmarks creation.

New toolbar is available on the right of the screen.

2 Click on the menu key Add  to add a bookmark for the page 
displayed

3 Click on the menu key Edit  to edit the bookmark, and modify 
if necessary the name of the bookmark. Click on Ok to confirm the 
modification or Cancel to cancel the modifications.

Fig. 27 Internet page opened with the Web Browser

Icon Definition

Go to the previous or next page loaded

Refresh the actual page

Exit the Navigation menu
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Web browser
– Click on  to open the page of the bookmark selected in the list

– Click on  to delete the selected bookmark from the list

– Click on  to exit the bookmark menu and go back to the Web 
Browser page.

Opening a PDF
document

PDF documents may be opened and read within the Web browser.

1 When you click on a link toward a PDF file, a dialog box during 
loading is displayed.

2 Once loading is completed, click on Ok to open the pdf file.

Leaving the
web browser

Depending on how long you want to leave the web browser and on your 
connection mode, you may:

– Leave the web browser running and switch to another task. To do 
this, click on the HOME button. 

Fig. 28 Bookmark edition

Fig. 29 Downloading a pdf file

NOTE

The web browser will open a PDF document, not a URL including a 
PDF file.

The PDF is also automatically saved on the disk of the 6000A V2 
Platform.
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Calculator
To go back, you must select again the Web Browser in the App’s 
menu: 

– The icon is valid  

– The application will reopen much faster, and all your environ-
ment will be the same (last current page, possibilities to go 
back...)

– Quit the application using the Web browser application menu: click 
on the key .

Calculator
A calculator can be displayed and used onto the 6000A V2 Platform.

1 In the Home page, press the App’s key

2 In the Application screen, select the icon Calculator.

The Calculator opens

Press  to exit the Calculator and go back to the Application page.

Press HOME button to go back to the Home page, and keep the Calcu-
lator application active.

File Explorer
This key allows to directly open the 6000A V2 Platform explorer, where 
all the files are stored (traces, pdf files ...).

The explanation about the explorer are available in “File management” 
on page 71.

Fig. 30 Calculator
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Chapter 8 Stratasync
8

This chapter describes how to synchronize your 6000A V2 Platform to 
the Stratasync application. 

The topics discussed in this chapter are as follows:

– "Principle and prerequisites of the Stratasync" page 60

– "Configuring and synchronizing the 6000A V2 Platform" page 61
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Principle and prerequisites of the Stratasync
Principle and prerequisites of the Stratasync
Stratasync is a new solution that provides network operators with an 
agile and centralized way to manage and analyze data from thousands 
of deployed Viavi test instruments directly from the cloud.

StrataSync is a hosted, cloud-based software application that provides 
Viavi instrument asset, configuration, and test-date management.

StrataSync improves technician and instrument efficiency. 

StrataSync allows to: 

– Manages and tracks test instruments

– Collects and analyzes results from the entire network

– Informs and trains the workforce

Pre-requisites for using the Stratasync with the 6000A V2 Platform

The user must have subscribed to Stratasync, and by consequence, he 
must have acquired an account Identifier and a password.

The Ethernet and Proxy parameters must have been correctly configured 
in the System Settings page of the 6000A V2 Platform (see “Ethernet > 
Mode” on page 65 and “Proxy > Use proxy” on page 66).

Fig. 31 Principle of the Stratasync application

Instruments are dialed 
in: the latest configura-

Techs are empowered: 
“right the first time” 

Visibility throughout the 
entire network:  all 

Lots of data 

Sim-
ple 
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Configuring and synchronizing the 6000A V2 Platform
Configuring and synchronizing the 6000A V2 Platform
The 6000A V2 Platform can be configured to be synchronized with the 
Stratasync.

1 Press Settings in the Home page

2 Check the configuration of the Ethernet and Proxy parameters.

3 Configure the Stratasync parameters:

a In the Server Type parameter, the Viavi Server is selected by 
default and it is recommended to keep this parameter.
However, the user can select if necessary the Server Name 
parameter and enter the name in the following parameter.

b In the Account ID parameter, enter the same identifier as the 
one used to access to Stratasync.

c The Technician ID parameter is automatically fulfilled after 
synchronization (if it has been defined by the administrator of 
the Stratasync)

d To upload the files from a directory onto the 6000A V2 Platform 
toward Stratasync, select the parameter Upload from and press 
right arrow key to enter the directory path (example: disk/
Stratasync). The directory Stratasync is defined by default.

Fig. 32 System Settings - Stratasync

3

2
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Configuring and synchronizing the 6000A V2 Platform
Connecting the
6000A V2

Platform to
Stratasync

Once 6000A V2 Platform is configured in the System Settings page:

1 Press Expert Tools > Upgrades menu keys.

2 Press Stratasync menu key .

The synchronization with Stratasync starts

The icon  displays on the upper banner of the Platform during 
synchronization.

Once the icon is no more displayed, this mean that the synchroniza-
tion is completed.

3 For the first synchronization only, a message displays on the Plat-
form to indicate the addition of the equipment in Stratasync.

The 6000A V2 Platform is now available in Stratasync.

Fig. 33 First synchronization - Message on 6000A V2 
Platform
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Platform Interface
9

The 6000A V2 Platform can be used in combination with a PC in order to 
transfer the Platform Interface onto a PC, or to access the internal 
memory or USB memory stick contents on the PC. 

Topics described in this chapter are as follows: 

– “Establishing connection” on page 64

– “Transferring the Interface” on page 67

– “Virtual control buttons bar” on page 68

– “Equivalence between the keyboard and 6000A V2 Platform” on 
page 68

For an intensive use of the deport screen or when it is used via a 
WAN network, it is strongly recommended to use a dedicated 
VNC client. The VNC clients recommended are Tight VNC (V 1.2.9 
or later) and Real VNC (V 4.1.1 or later).
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Establishing connection
Establishing connection
The connection between 6000A V2 Platform and the PC can be done 
directly, or via a local network.

The transfer of the interface can be done using a VNC window on PC.

Connecting the
6000A V2

Platform and
the PC

1 Connect the 6000A V2 Platform to the PC via an Ethernet cable, 
using the RJ45 connectors set on both equipments.

2 Check the network connection on the PC is set in Dynamic mode.

Configuring the
6000A V2
Platform

1 In the Home page, press System Settings menu key.

2 In the System Settings page, in the I/O Interfaces box, configure 
the following parameters:

Remote Screen

Remote screen = Session or Permanent must be confirmed in both 
cases, in the Interface E/S window.

No the screen cannot be remote on to a PC or on to
another 6000A V2 Platform.

Session Mode the Remote screen function is inactive once the
6000A V2 Platform is switched off.

Fig. 34 Connection 6000A V2 Platform and PC

NOTE

The transfer of interface can be done via WIFI, using the IP address 
once WIFI connection is established (see Chapter 12 “WIFI Option” 
page 109).

It can also be transferred via Bluetooth, on a laptop PC equipped with 
Bluetooth (see Chapter 13 “Bluetooth option” page 117).
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Establishing connection
Permanent Mode the Remote screen function is still active when
the 6000A V2 Platform is switched off and
restarted.

Permanent with password same function as the Permanent mode,
with an access to the equipment via VNC
protected by a password: 42000

The password to access VNC can be modified:

1 Click on the menu key Change password.

2 Enter the current password in the Edition keypad and press Enter to 
validate.

3 Enter the new password and press Enter to validate.

Ethernet > Mode

Parameters of the local Ethernet network to which the 6000A V2 Platform 
is connected:

Config 1 to 4 static mode enabling input of the configuration of
4 sites. If this parameter is selected, the following
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit 
menu.

– IP Address IP address of the 6000A V2 Platform

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access 
outside the sub-network.

– DNS1 IP address of the machine providing the IP 
address on the basis of the name

– Domain name name of the local network to which the 6000A V2 
Platform is connected.

Dynamic in this mode, which requires a DHCP server, the
6000A V2 Platform requests an IP address from
this server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.
After selecting this mode or after power-on, the
6000A V2 Platform tries to establish a connection
to obtain an address from a DHCP server. If for
any reason, this process fails, the 6000A V2
Platform reverses to static IP address mode with
User1 IP address.

1.Domain Name Server
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Ethernet IPv6 > Mode

The Ethernet IPV6 parameters must be configured to get Ethernet 
access in accordance with the IPV6 standards.

Config 1 to 4 static mode enabling input of the configuration of
4 sites. If this parameter is selected, the following
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit 
menu.

– Link: automatically displays the address of the link 
(cannot be modified)

– IP IP address of the 6000A V2 Platform

– GW IP address of the machine enabling access 
outside the sub-network.

– DNS IP address of the machine providing the IP 
address on the basis of the name

Auto in this mode, the 6000A V2 Platform requests an
IP address from the server which will be
allocated automatically.

If Auto is selected, the parameters Link, IP, GW and DNS are auto-
matically defined and cannot be modified.

Off The Ethernet IPV6 connection is not activated.

Proxy > Use proxy

1 Select No if no proxy is used.

If Manual has been selected, enter the Proxy Address.

If Auto has been selected, enter the Pac Address.

2 Note the IP Address displayed in the System Settings page.

NOTE

Once the 6000A V2 Platform is connected to the network, the icon 
 displays for few seconds and indicates the connection is working.

Fig. 35 Example of proxy configuration
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Transferring the Interface
3 Wait about 10 seconds the connection is established.

The 6000A V2 Platform Interface can now be transferred onto the PC, or 
the internal memory/USB key contents can be transferred on PC.

Transferring the Interface
Once the connection is established between the 6000A V2 Platform and 
the PC, proceed as follow:

1 Open Internet Explorer on the PC.

2 Considering 10.33.17.113 is the IP Address of the 6000A V2 Plat-
form (as shown Figure 36 on page 67), enter the following address 
in the Internet Explorer window:

http://10.33.17.113:5800
3 Press Enter to validate.

The screen of the 6000A V2 Platform appears offset on your PC.

Fig. 36 Example of configuration for Ethernet

Note the 6000A V2 
Platform IP Address

Fig. 37 VNC window

Click to install TightVNC software 
on your PC (not mandatory) 
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Virtual control buttons bar
You can use keyboard mouse of the PC to control the 6000A V2 Platform 
(see “Equivalence between the keyboard and 6000A V2 Platform” on 
page 68).

Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This 
virtual control buttons bar is especially useful when the 6000A V2 Plat-
form screen is exported on a remote PC.

To display those buttons, click once on the top of the screen in the status 
bar, at the same height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You 
may click on any of these buttons to obtain exactly the same results than 
using the hard keys on the front panel of the 6000A V2 Platform.

Equivalence between the keyboard and 6000A V2 Platform
The PC keyboard can replaced all the buttons and keys of the 6000A V2 
Platform except the ON/OFF button: 

– The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F7.

– The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

– The direction keys have the same function on the external keyboard 
and on the 6000A V2 Platform.

NOTE

Once Remote screen is accessbile via VNC, the icon  displays on 
the upper banner of the screen until the connection is cut or the 
6000A V2 Platform is switched off.

When two or more users are using remote screen function onto the 
same Platform, the icon is .

Fig. 38 Virtual control buttons bar
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Function on the 6000A V2 Platform External keyboard 

HOME Ctrl + H

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORTa

a. The Export function is available onto the Platform pressing simultane-
ously the left and right arrow keys.

Ctrl + P

¬  -  ®  ¯

Menu keys 1 to 7 (from top to bottom) F1 → F7

ABOUT F11

Save and quit (Exit) Entrée/Enter

Quit without saving (Abort) Escape/Echap.

NOTE

Those equivalences are also valid with a keyboard directly connected 
to the 6000A V2 Platform via one USB port.
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Equivalence between the keyboard and 6000A V2 Platform
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Chapter 10 File management
10

The files management with the 6000A V2 Platform can be performed, 
wether a module is set onto the equipment or not.

The topics discussed in this chapter are as follows:

– “File Explorer Overview” on page 72

– “Directories and Files selections” on page 72

– “Directories & Files editing functions” on page 73

– “Working with directories and files from the explorer” on page 74

– “Creating a screenshot” on page 83

– “Creating a report” on page 85

– “Merging pdf or txt files” on page 87

– “Storage media” on page 88
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File Explorer Overview
File Explorer Overview
To reach the File Explorer page

1 On the Home page, press App’s softkey.

2 Validate the File Explorer icon.

The File Explorer page appears.

Directories and Files selections

Directory
selection

To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the 
screen.

The list of files the directory contains displays on the right side

The selected directory is underlined in blue

2 Press validation hard key , to display the sub-directories if any.

Fig. 39 File Explorer page

Fig. 40 Directory selection

Selected directory

Sub-directory

Access to 
sub-directory
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Directories & Files editing functions
Files selection To select one or several files from the explorer page:

1 Press on files that must be selected.

or

To select a list of files using the keys of the Platform:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key  pushed until all the files are 
selected.

or

Click on Select all menu key to select all files into the directory.

Directories & Files editing functions

Copy/Cut &
Paste files/
directories

To copy (cut) one or several files, or one directory, and paste them in 
another place:

1 Select the directory / the file(s) (see “Directories and Files selec-
tions” on page 72).

2 Press Edit menu key

NOTE

The last selected file is underlined in red and the previous one(s) 
selected is/are underlined in blue. 

Fig. 41 Example of files selection

Selected 
files

Selected 
directory
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3 Press Copy to keep the directory / file(s) to their initial location.

or

Press Cut  to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new 
storage media.

5 Click on Paste menu key.

Renaming a
directory / file

1 Select the directory / file to be renamed (see “Directories and Files 
selections” on page 72).

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Deleting a
directory / file

1 Select the directory or file(s) to be deleted (see “Directories and 
Files selections” on page 72).

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Working with directories and files from the explorer

Creating a
directory

To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

Fig. 42 Edition keypad for renaming file
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2 Select the storage media into which the directory must be created

3 If you want to create a sub-directory, select the directory into which it 
must be created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files Once a file is selected, press Load, then Confirm Load menu keys.

File Types For files recognized by the 6000A V2 Platform, the types are symbolized 
by icons. E.g.

Several FO files of the same type (example: all otdr) cannot be 
opened at the same time using the Explorer function of the 
Application page; only the last one selected will open.
It can be opened exclusively if the corresponding module is set 
and activated and if File explorer is opened using the FILE button 
of the Platform).
Other type of files (PDF, TXT...) must be open one by one.

If different types of files have been selected in the Explorer, only 
the last one selected will open.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

OEO file (.OEO extension)

OSA file (.OSA extension)

PMD file (.PMD extension)

CD OTDR file (.CD extension)

AP file (.AP extension

ODM file (.OCD extension)

Power Meter file (.LTS extension)
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Sorting files If at least one file is selected, the key Sort allows to access to a sub-
menu allowing to sort the files according to pre-defined parameters:

– Sort by name: the files display in an ascending order (from A to Z). 
If you click once again on the key, the files display in a descending 
order (from Z to A).

– Sort by size: by clicking once on this key, the files display from the 
smallest to the heaviest one. Clicking a second time allows to sort 
the files in opposite order.

– Sort by type: clicking once on this key; the 6000A V2 Platform 
displays files in an ascending order (the file type A to file type W). By 
clicking again, the 6000A V2 Platform displays the files in opposite 
order.

– Sort by date: clicking once on this key; the 6000A V2 Platform 
displays files from the more recent to the less one. By clicking again 
on key, the Platform displays files from the older to the more recent 
one.

Icon Type of file

PDF File (.PDF extension)

PNG file (.PNG extension)

XML file (.XML extension)

JPEG / JPG file (.JPEG extension)

HTML file (.HTML extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)

With the 6000A V2 Platform, you can open and load any kind of 
Fiber Optic files (OTDR, OSA, PON...) even if the corresponding 
module is not installed.

NOTE

You can also sort files clicking on the column titles in the files list
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Transferring
files to a PC

with the USB
cable

If some Results traces or other kinds of file need to be transferred to the 
PC, this can be easily done using the USB cable delivered on standard 
with the 6000A V2 Platform.

Establishing
connection 6000A

V2 Platform <-> PC

1 Connect the 6000A V2 Platform to a PC, plugging the USB cable on 
the mini USB port of the Platform toward a USB port on the PC.

2 Once connection is established, a window opens automatically with 
the Flash driver:

3 Double click on the Flash driver.

The disk content of the Platform opens onto the PC.

Fig. 43 Direct connection 6000A V2 Platform <-> PC

Mini USB Port on the 
6000A V2 Platform

USB port on 
the PC

USB cable
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Transferring files
onto the PC

1 Select the file(s) from the 6000A V2 Platform to be transferred onto 
the PC

2 Press Ctrl + C, or right click and select Copy.

3 On the PC, select the directory in which file(s) will be transferred.

4 Press Ctrl + V, or right click and select Paste.

Cancelling the
connection

Once all desired files have been transfer onto the PC, connection 
between 6000A V2 Platform and PC can be removed:

1 On the PC, use the appropriate method to safely remove the USB 
cable from the USB port. 

The screen displays the results trace of the active function, or 
returns to the Home page if no function is active.

2 Remove the mini USB plug from the 6000A V2 Platform USB port.

Transferring
files to/from a
PC with a FTP

server

Il is possible, from a PC, to access the internal memory of the 6000A V2 
Platform or to the USB memory stick connected to the Platform by means 
of the FTP server of the 6000A V2 Platform.

Direct connection 1 Connect directly the 6000A V2 Platform to the PC with an Ethernet 
cable, using the RJ45 connectors on each equipment.

Fig. 44 Files selection from the 6000A V2 Platform
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2 Make sure the network configuration onto the PC is set to the 
Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected 
( ) and click once on it (underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address 
automatically is selected ( ); if not, click to select it.

h Click on Ok and close all the dialog boxes opened onto the PC.

3 On the 6000A V2 Platform, in the System Setup page, under I/O 
interface > Ethernet, select Dynamic.

Fig. 45 Ethernet Connection 6000A V2 Platform <-> PC

Fig. 46 Internet Protocol

Ethernet cable
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1 Note the IP Address and wait for about ten seconds while the 
connection is established.

Connection via a
local network

1 On the PC: find the IP address and the mask of the PC’s sub-
network:

– With Windows 98 or Millenium: Select Start > Execute, then enter 
winipcfg and click on OK. 

– With Windows NT, 2000, XP or Vista: select Start > Programs > 
Accessories > Dos Prompt, type ipconfig", then Enter. 

Note the IP address and the mask of the PC’s sub-network.

2 Plug the RJ 45 connector of the 6000A V2 Platform into a hub or 
Ethernet switch with an Ethernet cable (see Figure 45 on page 79).

3 On the 6000A V2 Platform: 
In the system set-up menu, under I/O interfaces > Ethernet, select 
Config 1 (or 2 / 3 / 4) on the line Mode, then enter the IP address, 
the IP mask of the PC and the IP gateway previously noted 
(step 1).

or

use Dynamic attribution mode (DHCP). In this case, the address of 
the 6000A V2 Platform (10.33.17.113 in the example) is 
displayed but cannot be modified.

4 Wait for about ten seconds while the connection is established.

5 On the PC, make sure that the connection is operational by 
selecting Start > Execute... and typing ping followed by the 
address of the 6000A V2 Platform.

Accessing the
internal memory of

the 6000A V2
Platform

FTP access is obtained through the user account «mts6000» (password: 
acterna).

1 Make the 6000A V2 Platform / PC connection as described 
Figure 45 on page 79 or connect Platform to WIFI (see 
Chapter 12 “WIFI Option” page 109).

2 On the PC, use an FTP client, and access to internal memory via an 
internet explorer (I.E, Mozilla Firefox...) or Windows Explorer.

Fig. 47 System Setup > Ethernet: Dynamic mode

IP Address of 
the Platform
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3 In the address bar, type the following address (10.33.17.113, 
being the IP address of the 6000A V2 Platform defined when the 
connection was configured;

ftp://mts6000:acterna@10.33.17.113/disk/
This allows to access to internal memory.

ftp://mts6000:acterna@10.33.17.113/usbflash/
This allows to access to the contents of the USB memory stick 
connected to the 6000A V2 Platform.

4 If an identification is required, enter:

– User name: mts6000

– Password: acterna

The PC then displays the contents of the internal memory or of the 
USB memory stick from the 6000A V2 Platform.

5 If internal memory of the Platform is accessible via Internet Explorer 
(or any other explorer), right click on one file and click on Save 
target as... to transfer file onto the PC.

If internal memory of the Platform is accessible via Windows 
Explorer, select one / several files and click on Copy, then click on 
Paste on PC to transfer file.

Sending files by
mail

The 6000A V2 Platform can send files (traces or others) via e-mail, from 
the Explorer.

If you use Internet Explorer 7, the following address must be entered:

ftp://mts6000:acterna@10.33.17.113/acterna/user/disk or 
ftp://mts6000:acterna@10.33.17.113/acterna/user/usb-
flash

Fig. 48 Internal memory of the 6000A V2 Platform

Internal memory open via Internet Explorer Internal memory open via Windows Explorer
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Configuring the
sending of files by

e-mail

Before sending files by e-mail, the unit must be configured:

1 On the Home page, press System Settings menu key

2 In the I/O Interfaces box, select File Export parameter.

3 Configure the following parameters;

Send Mail Choose Ethernet if you wish to use the sending
mail function.

Sender Mode Auto or Manual. 

In Auto mode, you will not have the possibility to
reply to the mail sent.

In Manual mode, the reply will be sent to the
address entered in the line From.Use the button

 to enter into an edition window.

Relay Mode Auto or Manual. 

If the e-mail sending is performed via a SMTP
network, select the Manual Relay mode and
indicate the SMTP server address in the field
Mail Relay, using the edition window.

In Auto mode, the sending of e-mail is performed
automatically.

Sending files from
the Explorer

1 Press HOME hard key

2 Press App’s menu key and validate File Explorer icon

3 In the Explorer page, select the file(s) to be sent.

4 Click on Export > Send by mail .

The editor is displayed

If Sender Mode is set to Auto, any reply to an e-mail sent by the 
6000A V2 Platform will be lost.

Fig. 49 File Export parameters
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5 You will have to fill in the two following fields:

– Mail To: in the edition window, enter the name of the recipient 
and press Enter to validate.

– Subject: enter the subject of the mail or a comment if neces-
sary. By default, the name of the mail is «Result + sending 
date».

6 Click on Enter

Once the mail has been sent, the following message is displayed: Mail 
Sent. Click on any key to follow.

Creating a screenshot
You can create captures of what is displayed on the screen, directly from 
the 6000A V2 Platform.

Configuring the
parameters of

screenshots

To configure the screenshot and choose the format of the generated file:

1 On the Home page, press System Settings key to reach the 
System Settings page.

2 In the Printer box, on the line Printer, select File (Screen)

Fig. 50 Enter e-mail address

Enter an e-
mail address

NOTE

If at least one function is selected in the System page (yellow icon), 
this two parameters «Mail to» and «Subject» can be configured by 
default in the Setup page > File Export (see 8100 Module Manual)
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Choosing this option, you can save the displayed screen in JPG, 
PNG or PDF format, exactly as it is displayed on the screen.

Therefore, if you make a zoom on the trace for example, the file will 
only show the zoom section.

3 On the line File format, select if the exported file will be a JPG, PNG 
or PDF file.

Taking a
screenshot

Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

2 If necessary, make modifications on this display (example: zoom on 
trace...)

3 Press simultaneously left and right direction keys

or

Click on the upper banner of the screen, and click on Print in the 
control buttons bar displayed for few seconds.

The icon  displays until the end of process.

4 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

For trace results, the file is saved in the same directory than the file 
used for screenshot.

For other page open and used for a screenshot, the file is saved in 
the directory Stratasync, into the disk.

Name of the
screenshots

files

The screenshot is saved in a file, which is automatically named as follow: 

– Print_date (year/month/day)_time (hour/minut/second).jpg/png/pdf

Fig. 51 Example of screenshot, open in the Web Browser of 
the 6000A V2 Platform
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Creating a report
Once the results page of a function is opened (example: OTDR trace, 
Power Meter results...), it can be exported in a report, using the 6000A 
V2 Platform.

Configuring the
report

To configure the report and choose the format of the report file:

1 On the Home page, press System Settings key to reach the 
System Settings page.

2 In the Printer box, on the line Printer, select File (Formatted).

Choosing this option, you can save the open file in a JPG, PNG or 
PDF file report, exactly as if the file was printed on paper. 

Therefore, if the file is too large for one A4 page, several JPG, PNG 
or PDF files will be created.

3 On the line File format, select if the report file will be a JPG, PNG or 
PDF file.

4 To display a Logo on the upper right of the report pages, click on 
Logo line and select the Logo to be displayed on the upper right of 
the page: 

a Press  to open the edition keypad

b Enter the path of the logo file with its extension (example: disk/
Logo.jpg)

c Press  to validate.

Creating the
report

1 Open the file to be saved in a report in JPG, PNG or PDF format

2 If necessary, make the modifications on the file/trace (see user 
manual of the 8100 OTDR Modules for OTDR trace files).

3 Set the trace view as wished.

Fig. 52 Example of Report configuration
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For OTDR traces

– if the function is set to the Trace mode (Trace is selected on the 
menu key Trace/Summary), the JPG/PNG/PDF file will contain 
the header and the trace (in one page).

– If the function is set to Table mode, the JPG/PNG/PDF file will 
contain the header, the trace and the entire results table (several 
pages may be required)

– If the function is set to Summary mode (Summary is selected 
on the menu key Trace/Summary), the JPG/PNG/PDF file will 
contain the header and the summary page, with either  the Bend 
table or the Alarm Table according to the selected item with the 
menu key.

This view is only available with OTDR traces.

4 Press simultaneously left and right direction keys

or

Click on the upper banner of the screen, and click on Print in the 
control buttons bar displayed for few seconds.

The icon  displays until the end of process.

5 Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the same directory than the trace file used for 
report.

Name of the
report

If a trace has been saved in a report file, the name of the JPG/PNG/PDF 
file is as follow:

– name of the stored trace_date (year/month/day)_time (hour/minute/
second).jpg/png/pdf
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Merging pdf or txt files
In the Explorer page, two pdf/txt files or more, generated via the results 
traces can be merged in one pdf file.

– The pdf files that can be merged are those generated via the Fast 
Report key on trace results page or via the EXPORT hardkey of the 
6000A V2 Platform (see “Creating a report” on page 85)

– The txt files that can be merged are those saved with the results 
trace (see OTDR Modules User Manual: E8100M02).

1 In the Explorer, select the two or more pdf/txt files generated

2 Press Export menu key

3 Press Merge key

Fig. 53 Example of report (in pdf)
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The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name 
by default is: merged_year_month_date__hour_min_sec.pdf 

The file is automatically saved in the same directory as the one where 
files have been selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in 
one single pdf file of several pages (1 results screen per page, if the 
results table does not exceed one page).

Storage media
For saving or recalling data, the 6000A V2 Platform offers a wide choice 
of media, both built-in and external.

Free space on selected media is clearly displayed at the bottom of the 
left panel.

Storage media
built into the

6000A V2
Platform

The 6000A V2 Platform is delivered with an internal memory , which 
maximum capacity is of 2 Gbytes (with a minimum of about 128 MB are 
available for data storage).

Fig. 54 Files selection and Merge key

NOTE

Once merged file is saved, it can be renamed in the Explorer (see 
“Renaming a directory / file” on page 74).
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The 6000A V2 Platform can also be delivered with a hard disk, available 
on option, which maximum capacity is of 100GB. It must be used with 
Transport applications.

External USB
storage media

The 6000A V2 Platform is equipped with 2 USB ports as standard. One 
of these can be used to connect an external storage medium, in partic-
ular a USB memory stick.

USB memory stick
connection

1 Insert the USB memory stick in one of the 6000A V2 Platform's USB 
port. 

A sound is emitted to confirm the successful insertion and recogni-
tion of a USB memory stick.

Then, the icon  is displayed in the upper banner to inform the 
user the USB stick is ready to be used.

USB memory stick
disconnection

1 Before disconnecting the USB memory stick, always select a 
storage device different from usbflash (select disk for example) in 
the explorer. 

2 Make sure you no longer have any running applications using the 
usbflash storage media.

3 Press the Eject USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this 
state, the USB stick cannot be used anymore

The USB memory stick can then be disconnected from the USB port.

See Chapter 16 “Maintenance and Troubleshooting” page 137 if any 
problem occurs with the USB memory stick

NOTE

Although three USB ports are present, it is not possible to use simul-
taneously more than one external USB storage medium. 

When a file is moved in the explorer of the Platform, the end of 
the move on the screen does not mean that writing of data into 
the memory is complete. Some data may still be in a writing 
process if the storage unit is removed prematurely. 

NOTE

The USB memory stick can also be removed using the Expert Tools 
> Media Utilities menu, accessible via the Home page.
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Cloud Storage

Principle and
prerequisites of

the Cloud Storage

The Cloud storage defined the outsourcing of data on distant servers, 
which avoid the data storage on a local workstation.

The cloud storage onto a 6000A V2 Platform allows to transfer the files 
from the Platform toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create 
an account on a Cloud Platform on internet. 

The Cloud storage function onto the 6000A V2 Platform works exclu-
sively with sites using the WebDav technology such as CloudSafe 
(https://secure.cloudsafe.com/pages/index.html) or Box (https://
www.box.com/pricing/).

Once account is created, with WevDav configuration, you get the 
following information for connection:

– URL 

– Login Name

– Login Password

Configuring and
connecting to

Cloud Storage on
the 6000A V2

Platform

Configuring the 6000A V2 Platform

Once an account has been created on the Cloud site, configure the Plat-
form before establishing the connection.

1 On the Home page, press Settings to reach the System Settings 
page

2 In the I/O Interfaces windows, press Cloud Storage parameter

A new menu opens

3 In the Url parameter, enter the URL define for the Cloud server 
created on internet

4 In the User parameter, enter your Login created on your account

5 In the Key / Password, enter the password attributed by the Cloud 
server.

Before configuring the Cloud Storage, make sure the 
configuration for Ethernet parameters and Proxy parameters are 
correctly configured. See “Ethernet > Mode” on page 65 and 
“Proxy > Use proxy” on page 66.
90 User Manual 76100000200 Rev. 001

https://www.box.com/pricing/
https://www.box.com/pricing/


Chapter 10 File management
Storage media
Connecting Cloud Storage

Once configuration has been established on the 6000A V2 Platform, it is 
ready to be connected with Cloud server:

Select one parameter of the Cloud Storage window on 6000A V2 Plat-
form

1 Press Connect Cloud Storage menu key .

The connection launches

2 Once connection is established, a message displays in the window

3 Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connection 
is active.

Disconnecting from Cloud storage

To disconnect the 6000A V2 Platform from Cloud storage:

1 Press HOME hard key.

2 Press System Settings menu key.

3 Select a parameter of the Cloud Storage window.

4 Press Disconnect Cloud Storage menu key.

Fig. 55 Example of configuration

Configuration on Cloud server (example with 
Configuration on 
6000A V2 Platform
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Transferring files
using Cloud

Storage

Once connection between 6000A V2 Platform and cloud storage server 
is successfully established, the files can be transferred from one Platform 
to the other.

1 Press HOME hard key.

2 Press FILE Explorer on the Home page

In the Explorer page, a new storage media is available: cloud-
storage.

3 Transfer the files from the disk or USB memory stick of the 6000A 
V2 Platform toward the cloud storage or vice-versa:

a Select the file(s) to be transferred

b Press the Edit > Copy or Cut menu keys

c Select the storage media (and directory) into which files must be 
copied.

d Press Paste menu key.

The cloud-storage media is not available when File Explorer is 
opened from a FO application.

Fig. 56 File Explorer with cloud storage

Edition 
menu

The cloud storage is automatically disconnected once the 
Platform is switched off. Reconnect from the System Settings 
page of the 6000A V2 Platform after the Platform restart.
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Abbreviations
for storage

media

The abbreviations used in the explorer for the different storage media 
are:

Abbreviation Storage medium

disk Internal flash memory

harddisk Internal harddisk (option)

usbflash USB memory stick

cloud-storage Cloud storage media available on PC

bluetooth-inbox Bluetooth storage media (option)a

a. The files stored in bluetooth-inbox are lost when the Platform is 
switched off.
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11

The 6000A V2 Platform can be accessible to any network test locations, 
using a specific function: Smart Access Anywhere. 

This function allows one distant user, on a PC, to transfer the Platform 
Interface and work on 6000A V2 Platform or to access the internal 
memory / USB memory stick contents on the PC and perform files 
transfer from T-BERD/MTS to PC and vice-versa.

This feature does not need any licence code if the user wants assis-
tance from a Viavi person located within the Viavi network.

This feature requires a licence code into the unit if the user wants any 
other assistance/support (“company A” willing to be remotely controlled 
by “company A or B”).

Multiple licences are available:

– Licence 1 (reference SAA-6K-L1): for SmartAccessAnywhere 
using Ethernet or Wifi hotspot connection

– Licence 2 (reference SAA-6K-L2): for SmartAccessAnywhere 
using Ethernet, wifi hostpot connection, or USB / Wifi connection 
through 3G smartphone

– "Connection modes" page 96

– "Pre-requisite for using the Smart Access Anywhere Application" 
page 98

– "Downloading the application on PC" page 98

– "Launching the SmartAccess Anywhere application" page 99

– "Using Remote screen and File Transfer applications" page 101

– "Connection information and settings" page 105
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Connection modes
Different kinds of connection are available to access to a distant 6000A 
V2 Platform.

According to the connection type used, specific requirements are 
mandatory.

Ethernet or
WIFI

connection

1 Using the Ethernet connection, no specific requirement is needed. 
The 6000A V2 Platform is directly connected to Internet via an 
Ethernet Cable.

2 The WIFI connection can be used to access to 6000A V2 Platform 
from any location.

This connection is available exclusively if the WIFI option is 
installed onto the T-BERD/MTS-6000A V2 which will be seen 
remotely.

Fig. 57 Ethernet connection

Fig. 58 WIFI connection
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USB/WIFI
connection
through 3G

Smartphone

To access to a Platform remotely, the connection between the unit and 
the Viavi application can be established via a USB cable or WIFI, and 
through a 3G Smartphone, having Internet Sharing capability via USB or 
WIFI.

1 To establish connection between 6000A V2 Platform and Smart-
phone using USB, connect the USB cable on 6000A V2 Platform 
and on 3G Smartphone connector.

2 To establish connection between 6000A V2 Platform and 3G Smart-
phone using WIFI, the WIFI option must be installed onto the 
6000A V2 Platform.

Fig. 59 USB connection through 3G Smartphone

Fig. 60 WIFI connection through 3G Smartphone

The smartphone which have been fully qualified are HTC Desire 
and Samsung Galaxy Ace models.
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Pre-requisite for using the Smart Access Anywhere Application
To access to a 6000A V2 Platform from any locations, specific require-
ments are mandatory:

– a licence installed on Platform which will be accessible from any 
locations.

– an Ethernet connection (the Platform must have an IP address - see 
“Ethernet > Mode” on page 65) and, if the network uses a proxy, this 
proxy must be configured (see “Proxy > Use proxy” on page 66).

– the Viavi application, downloaded for free at the address «http://
smartaccess.updatemyunit.net».

– port 22 (SSH) or 443 (HTTS) output opened

– according to connection mode selected:

– the WIFI option installed on 6000A V2 Platform

– a USB cable to connect Platform with 3G Smartphone

– a 3G Smartphone from given list and having appropriate basic 
subscription for internet connection sharing

Downloading the application on PC
The application Smart Access Anywhere must be downloaded on the 
PC which will be connected to the 6000A V2 Platform remotely.

1 On PC, open an internet explorer and type the following address: 
http://smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.zip

3 Select Save in the dialog box.

Once download is completed, the internet explorer can be closed.

4 Open the directory into which has been save the zip file and unzip 
files into a directory

5 Open the directory and double click on SmartAccessAny-
where.exe 

The Smart Access Anywhere application opens:

NOTE

It is not necessary to have administrator privileges to install the appli-
cation on PC. This application is just saved on PC.
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If the software version is not the last one available, a message displays, 
on the upper part of the screen to indicate the latest version available can 
be downloaded at the address: http://smartaccess.updatemyunit.net.

Launching the SmartAccess Anywhere application
Once connection is configured, the SmartAccess Anywhere application 
can be launched

On 6000A V2
Platform

1 On the Home page, press Expert Tools 

2 Press Access Anywhere menu key 

The connection to SmartAccessAnywhere Server is in progress.

Fig. 61 Smart Access Anywhere: Connection page

Fig. 62 Warning message of a new version available

Enter Access Code (see step 1 on page 100)
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3 Once connection is established with the server, the 6000A V2 Plat-
form displays a message with the code to be used to access to the 
equipment remotely.

4 Note this access code and transfer it to the distant user, who will 
access the unit remotely.

5 Press OK to hide the message.

On the distant
PC

1 On the PC of the distant user, once the application is launched, 
enter the Access Number on the upper part of the screen.

Fig. 63 Connection to SmartAccessAnywhere Server in 
progress

Fig. 64 Access code displayed
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2 Click on Connect to validate 

The following screen displays:

Using Remote screen and File Transfer applications
Once the Introduction page is displayed, the user can work on distant 
6000A V2 Platform:

– transfer the interface to work on the unit (perform acquisition, 
configure the equipment...)

– transfer files from the equipment toward the PC, and vice-versa.

Transferring the
interface onto

the PC

To display the remote 6000A V2 Platform onto the PC:

1 On the Introduction page, click on  

or

On the left menu, click on 

The current screen of the 6000A V2 Platform displays:

Fig. 65 Smart Access Anywhere: Home page

Information 
on connection

After remote upgrade or reboot, please wait for more than 2 
minutes before re-starting the link between the PC and the unit 
with SmartAccessAnywhere.
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The VNC icon  on the upper banner of the unit indicates the 
remote screen is active.

2 Click on the upper banner of the 6000A V2 Platform screen to 
access to the virtual control buttons bar, which allows to emulate 
hard keys.

You may click on any of these buttons to obtain exactly the same 
results than using the hard keys on the front panel of the 6000A V2 
Platform.

3 You can use keyboard mouse of the PC to control the 6000A V2 
Platform.

Equivalence between the keyboard and 6000A V2 Platform

The PC keyboard can replaced all the buttons and keys of the 6000A V2 
Platform except the ON/OFF button: 

– The menu keys to the right of the screen are replaced by the func-
tion keys F1 to F7.

– The buttons below the screen are equivalent to Ctrl + a letter (see 
table below).

– The direction keys have the same function on the external keyboard 
and on the 6000A V2 Platform.

Fig. 66 Smart Access Anywhere: Remote screen

Function on the 6000A V2 Platform External keyboard 

HOME Ctrl + H
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Using Remote screen and File Transfer applications
Transferring
files

To work on files (onto PC and onto unit):

1 On the Introduction page, click on .

or

On the left menu, click on .

The file Explorer on PC and the one of the Platform displays:

SYSTEM SETTINGS F12

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

←  ↑  →  ↓
Menu keys 1 to 7 (from top to bottom) F1 → F7

ABOUT F11

Save and quit (Exit) Enter

Quit without saving (Abort) Escape

a. The Export function is available directly on the 6000A V2 Platform 
pushing simultaneously the left and right arrow keys.

Function on the 6000A V2 Platform External keyboard 

Fig. 67 File Transfer page

PC
Directories and files

6000A V2 Platform
Storage media available
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2 Double-click on one directory/storage media to display the contents 
(directories / sub-directories / files)

Navigation buttons
 

Transferring files
from PC to 6000A

V2 Platform

1 On the Platform explorer, select the storage media, and if wished 
the (sub-)directory into which file will be transferred.

2 On the PC file explorer, select the file to be transferred

3 Click on the button Upload .

At the bottom of the screen, a new banner displays with information 
on file transfer:

Once transfer is completed, the banner disappears and the transferred 
file is underlined in blue on Platform explorer.

Transferring files
from 6000A V2
Platform to PC

1 On the PC explorer, select the storage media, and if wished the 
(sub-)directory into which file will be transferred.

2 On the file explorer of the Platform, select the file to be transferred.

3 Click on the button Download .

A dialog box open, allowing to modify the location on PC of the file.

Return to the Home directory

Select the PC drive in the list

Access to parent directory

clic

Fig. 68 Information on file transfer

1
2
3
4

1: location of the uploaded file on 
PC

3: level of transferred 
data

2: location of the file on 6000A V2 4: bar graph of the trans-

NOTE

Only one file can be uploaded from PC to Platform at the same time.
104 User Manual 76100000200 Rev. 001



Chapter 11 Smart Access Anywhere
Connection information and settings
4 Select the directory into which file will be saved.

5 Press Save to start the transfer

Under both file explorers, a new banner displays with information on 
file transfer (see Figure 68 on page 104).

Once transfer is completed, the banner disappears and the transferred 
file is underlined in blue on PC explorer.

Working with
files and

directories on
6000A V2
Platform

Renaming file or directory

1 Select a file/directory stored on the 6000A V2 Platform hard disk or 
USB key.

2 Click on .

3 In the new dialog box opened, enter a new name
for the file/directory, keeping the file extension.

4 Press OK to validate.

Deleting file

1 Select a file stored on the Platform hard disk or USB key.

2 Click on .

3 In the new dialog box opened, press Yes to
confirm the deletion (or No to keep the file).

Creating a new directory

1 Select the storage and, if wished, the directory into which the new 
directory will be stored.

2 Click on .

3 In the new dialog box opened, enter a name for
the new directory (newdir is given by default).

4 Press OK to validate.

The new directory is automatically created at the
location selected.

Connection information and settings

Displaying
session

information

At any time during application use, the information about the session in 
progress can be displayed.

1 Press Session menu key on left of the screen 

2 A screen as the following one displays:
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Connection information and settings
This page gives information on connection «in real time».

Modifying
connection

settings

To modify the settings for connection to internet:

1 Press Session menu key on left of the screen .

2 Disconnect from application pressing  .

3 On the session screen (see Figure 69 on page 106), press button 
.

The following screen displays:

By default, the connection is defined to Smart-guess (default).

Fig. 69 Session page

Fig. 70 Connection settings
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4 To modify the current parameters, select Forced settings.

The parameters for Port and HTTPS configurations turn automati-
cally active.

5 Modify, if necessary, the parameters for SSI tunnel port and/or 
Internet proxy.

The Internet proxy configuration is available exclusively if the port 
selected is Alternative port (443) and if the HTTPS packing is 
selected.

6 Once configuration is completed, press .

The Home page displays (see Figure 65 on page 101).

Testing
connection

Before entering the Access code to activate the application, the connec-
tion to internet can be tested from displayed screen.

1 Open the Smart Access Anywhere application on PC

2 Press  button

The test is automatically launched

3 Press  to display logs in real time

Once completed, the results for connection display:

It is recommended to configure parameters of connection with 
your local network administrator, if the default parameters need 
to be modified.

Fig. 71 Test results
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The screen displays, in two different tables:

– the Upload and Download speed (in Kbyte/s) from Device to server.

– the Latency between Device and server (in ms).

1 Press  to delete the current table, and retest connection 
if wished.

2 If connection is valid, enter the access code and establish connec-
tion (see “Launching the SmartAccess Anywhere application” - “On 
the distant PC” on page 100).
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Chapter 12 WIFI Option
12

The WIFI application is available on option with the 6000A V2 Platform, 
and installed in factory, except if it has been ordered after the Platform 
delivery, in which case the customer must install himself the option (see 
“Installing the WIFI or Bluetooth option” on page 140).

The topics discussed in this chapter are as follows:

– "Configuration of the WIFI option" page 110

– "Connection to SSID" page 111

– "Configuring the WIFI mode to which the Platform is connected" 
page 112

– "Transferring the 6000A V2 Platform interface via WIFI on a PC" 
page 114

– "Transferring files to/from a PC via WIFI" page 115
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Configuration of the WIFI option
Configuration of the WIFI option
The WIFI option is delivered on a USB key installed into the Platform.

A new icon displays on the upper banner  once installation of the 
option is performed and Platform is re started.

To display the Wifi configuration screen:

1 Press HOME hard key to reach the Home page.

A new menu key is displayed on the right of the screen .

2 Press the menu key to display the WIFI Setup screen.

Configuring the
WIFI access

Once the Setup screen is displayed, configure the WIFI connection:

1 In the Configuration box, check the parameter 802.11 is set to 
Enable.

If the parameter is defined to Disable, the WIFI application is deacti-
vated, and the icon  is no more displayed on the upper banner.

2 Press Scan SSID menu key to scan for Service Set Identifiers 
(SSIDs) in the area.

3 Wait for the list of SSIDs to be displayed.

Fig. 72 WIFI Setup screen
110 User Manual 76100000200 Rev. 001



Chapter 12 WIFI Option
Connection to SSID
4 Select the desired network to connect to.

5 Press Select menu key to validated the connection.

The display goes back to Setup screen.

The SSID parameter is automatically configured with the one 
selected.

6 In Encryption parameter, select the type of encryption wished: 
None, WEP Static, WPA Personal, WPA Enterprise.

7 According to encryption type selected, enter Login (if any needed) 
and Key/Password.

8 In the AutoConnect parameter, select if the connection to SSID 
selected must be done automatically (On) or not (Off).

Connection to SSID
Once configuration is valid, connect the 6000A V2 Platform to the Wire-
less network:

1 In the Setup screen, press Connect SSID menu key.

or

If AutoConnect is defined to On, the connection is launched auto-
matically.

Fig. 73 List of SSIDs found

NOTE

Login and Password are kept in memory, even if the WIFI is deacti-
vated or the 6000A V2 Platform switch off and restarted.e
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Configuring the WIFI mode to which the Platform is connected
Once association of Platform with SSID is established, the icon    
becomes  to indicate the connection is active.

Configuring the WIFI mode to which the Platform is connected
To work on WIFI with the Platform, configure the 802.11 or 802.11 IPV6 
parameters on the Setup screen.

1 If 802.11 box is chosen, select the mode of connection: 

Config 1 to 4 static mode enabling input of the configuration of
4 sites. If this parameter is selected, the following
parameters must be entered:

– Site Name the user can enter the name of the site in the Edit 
menu.

– IP Address IP address of the 6000A V2 Platform

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access 
outside the sub-network.

– DNS (Domain Name Server) IP address of the 
machine providing the IP address on the basis of 
the name

– Domain name name of the local network to which the 6000A V2 
Platform is connected.

Dynamic in this mode, which requires a DHCP server, the
6000A V2 Platform requests an IP address from
this server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.
After selecting this mode or after power-on, the
6000A V2 Platform tries to establish a connection
to obtain an address from a DHCP server. If for
any reason, this process fails, the 6000A V2
Platform reverses to static IP address mode with
User1 IP address.

Note the IP address of the Platform, to be able to remote screen on PC 
or to transfer files.

Fig. 74 WIFI connection in Dynamic mode

Note IP 
Address
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Configuring the WIFI mode to which the Platform is connected
In 802.11 IPv6 mode, the following parameters (Link, IP, GW and DNS) 
are automatically defined and cannot be modified

1 The 802.11 IPv6 box is to be used if connection must be in confor-
mance with the IPV6 standards. Select the mode of connection: 

Config 1 to 4 static mode enabling input of the configuration of
4 sites. If this parameter is selected, the following
parameters are available:

– Site Name the user can enter the name of the site in the Edit 
menu.

– Link automatically displays the link name (cannot be 
modified)

– IP IP address of the Platform

– GW IP address of the machine enabling access 
outside the sub-network.

– DNS IP address of the machine providing the IP 
address on the basis of the name

Dynamic in this mode, which requires a DHCP server, the
6000A V2 Platform requests an IP address from
this server which will be allocated dynamically if
dynamic host configuration is activated on the
local network.
After selecting this mode or after power-on, the
tries to establish a connection to obtain an
address from a DHCP server. If for any reason,
this process fails, the 6000A V2 Platform
reverses to static IP address mode with User1 IP
address.

If Dynamic mode is selected, then the following parameters (Link / IP / 
GW / DNS) are automatically configured and cannot be modified 
(greyed).

Fig. 75 WIFI connection in Dynamic mode with IPV6
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Transferring the 6000A V2 Platform interface via WIFI on a PC
Transferring the 6000A V2 Platform interface via WIFI on a PC
Once the IP address is displayed in the configuration screen.

1 On the PC connected to WIFI with the Platform, open Internet 
Explorer.

2 Considering 10.33.16.229 is the IP Address of the 6000A V2 Plat-
form (as shown Figure 74 on page 112), enter the following address 
in the Internet Explorer window:

http://10.33.16.229:5800
3 Press Enter to validate.

The screen of the 6000A V2 Platform appears offset on your PC.

See “Virtual control buttons bar” on page 68 and “Equivalence between 
the keyboard and 6000A V2 Platform” on page 68 to get information on 
the deported screen use.

Fig. 76 VNC window

Click to install TightVNC 
software on your PC (not 
mandatory) 
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Transferring files to/from a PC via WIFI
Once connection is established between the Platform and the PC:

1 On the PC, use an FTP client, and access to internal memory via an 
internet explorer (I.E, Mozilla Firefox...) or Windows Explorer.

2 In the address bar, type the following address (10.33.16.229 
being the IP address of the 6000A V2 Platform defined when the 
connection was configured):

ftp://mts6000:acterna@10.33.16.229/disk/
This allows to access to internal memory.

ftp://mts6000:acterna@10.33.16.229/usbflash/
This allows to access to the contents of the USB memory stick 
connected to the 6000A V2 Platform.

3 If an identification is required, enter:

– User name: mts6000

– Password: acterna

The PC then displays the contents of the internal memory or of the 
USB memory stick from the 6000A V2 Platform.

4 If internal memory of the Platform is accessible via Internet Explorer 
(or any other explorer), right click on one file and click on Save 
target as... to transfer file onto the PC.

If internal memory of the Platform is accessible via Windows 
Explorer, select one / several files and click on Copy, then click on 
Paste on PC to transfer file.

If you use Internet Explorer 7, the following address must be entered:

ftp://mts6000:acterna@10.33.16.229/acterna/user/disk or 
ftp://mts6000:acterna@10.33.16.229/acterna/user/usbflash

Fig. 77 Internal memory of the 6000A V2 Platform

Internal memory open via Internet Explorer Internal memory open via Windows Explorer
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Transferring files to/from a PC via WIFI
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Chapter 13 Bluetooth option
13

The Bluetooth application is available on option with the 6000A V2 Plat-
form, and installed in factory, except if it has been ordered after the Plat-
form delivery, in which case the customer must install himself the option 
(see “Installing the WIFI or Bluetooth option” on page 140).

The topics discussed in this chapter are as follows:

– "Setting up a Bluetooth connection" page 118

– "Transferring files via Bluetooth" page 121

– "Transferring the Platform interface on a laptop PC via Bluetooth" 
page 122

– "Removing the Pairing" page 124

The product is approved in accordance to R&TTE directive 
concerning transmitter module marked by CE0678. It is 
manufactured by MITSUMI and it is an OEM product.
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation. This device contains FCC-ID: POOWML-
C40.
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Setting up a Bluetooth connection
Setting up a Bluetooth connection
The Bluetooth option allows file transfers between the 6000A V2 Plat-
form and another device

1 On the Home page, press System Settings key

2 Under I/O interfaces, select Bluetooth > Enable

The icon  is displayed on the upper banner of the screen

3 Push the Bluetooth Pairing key 

The Paired Bluetooth screen appears

4 Press the Become Pairable soft key to wait for another device to 
initiate the connection to the 6000A V2 Platform.

A screen as the following one displays:

5 Activate Bluetooth on the equipment which need to be paired with 
the Platform

6 If you are asked to, enter a pairing code on the equipment.

7 In this case, once the pairing code is validated on the equipment, 
enter the same pairing code on the Platform to validate the connec-
tion:

Fig. 78 Waiting for pairing
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Setting up a Bluetooth connection
8 Press Enter to validate.

Both equipment are now paired:

The icon has a blue background when paired with a device , 
versus no background when not paired .

If the desired device is not displayed on the screen, or if no devices are 
detected, press the Search Devices soft key.

The 6000A V2 Platform is searching for the devices which could be 
used via Bluetooth with the equipment.

Fig. 79 Enter Pairing code

Fig. 80 Platform paired with one equipment
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Setting up a Bluetooth connection
A baragraph is displayed during research  

Once the research is completed, a list of the available devices is 
displayed, with the level of detection of the 6000A V2 Platform 

a Using the direction keys  and  or touchscreen, select the 
device to be paired with the Platform

It will be underlined in blue

b Push the Pair key to connect the device to the Platform

1 If prompted, enter a pairing code. The code must be identical on the 
6000 and the device.

2 Once the bluetooth device and the Platform are paired, a screen is 
displayed with the description of the device (see Figure 80 on 
page 119).

The icon has a blue background when paired with a device , 
versus no background when not paired .

You can now go to the file explorer and transfer files from the 6000A V2 
Platform toward the bluetooth device and vice versa (see “Transferring 
files via Bluetooth” on page 121) or transfer the Platform interface on 
VNC via Bluetooth (see “Transferring the Platform interface on a laptop 
PC via Bluetooth” on page 122).

REMINDER
You may need to activate bluetooth on the other device to allow 
pairing.

Fig. 81 List of devices found
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Transferring files via Bluetooth
Once the connection has been established with a bluetooth device:

1 Press the HOME key and then press the System Settings soft key.

2 Use the down arrow  or touchscreen to move to the I/O Inter-
faces settings and then to File export.

3 In the Send Mail parameter, select Bluetooth and then exit the 
menu.

4 On the Home page, press App’s menu key and select File 
Explorer icon to go in the File Explorer.

5 Select the file(s) to be transferred from the Platform toward the PC.

6 Push Export > Send by Bluetooth menu keys .

A confirmation message displays once the transfer is completed.

You can also transfer file(s) from the bluetooth device toward the Plat-
form.

In this case, the files received will be stored in a storage media created 
automatically on the Platform: bluetooth-inbox.

Fig. 82 Configuration of files sending by Bluetooth

Fig. 83 Confirmation of files sending
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Transferring the Platform interface on a laptop PC via Bluetooth
If the 6000A V2 Platform is paired with a laptop equipped with Bluetooth, 
the interface can be transferred on this PC in order to work on the unit 
from the laptop PC.

To remote the screen

1 Install the Remote Operation application on the laptop PC:

a Download the application

b Double click to launch it and follow the instruction for installation

The application is available on PC, in Start > All Programs > Viavi 
> Remote Operation.

2 Pair the 6000A V2 Platform with laptop PC via Bluetooth (see 
“Setting up a Bluetooth connection” on page 118).

3 Once pairing is active, open the Remote Operation application on 
laptop PC.

A new window opens, and scanning is automatically launched to 
find the equipment paired with laptop PC.

4 Once scanning is completed, the 6000A V2 Platform displays the list 
of detected equipment.

Fig. 84 Confirmation of file receiving

WARNING
The files stored in bluetooth-inbox will be lost once the 6000A V2 
Platform is switched off. Copy/Paste the files to keep toward 
another storage media (disk, usb key...).
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Transferring the Platform interface on a laptop PC via Bluetooth
1 Click on View Unit button to remote the screen on PC.

The current screen of the 6000A V2 Platform displays on a new 
window on the PC.

In the small window next to VNC window (see Figure 85 on 
page 123), the button View Unit becomes Stop Viewing.

See “Virtual control buttons bar” on page 68 and “Equivalence between 
the keyboard and 6000A V2 Platform” on page 68 to get information on 
use of PC to work on 6000A V2 Platform.

Closing the remote screen and the application

To stop using the remote screen on PC:

1 In the small window available with the VNC window (see Figure 86 
on page 123) click on Stop Viewing button.

The VNC window closes.

Fig. 85 6000A V2 Platform detected via Bluetooth on PC

Fig. 86 Remote screen on PC

Launch a new 
Scan to detect 
new unit(s)
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Removing the Pairing
At any time, the remote screen can be displayed back clicking on 
View Unit button.

2 To close the application, click on File > Exit in the window.

Removing the Pairing
1 To remove the pairing between the two equipments, in the System 

Settings page, push the Bluetooth Pairing key

2 In the screen displayed, push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the 
Platform is no more connected to a bluetooth device, but the Bluetooth 
option is still active.

To deactivate the bluetooth onto the Platform, go in the System Settings 
page, and under I/O Interfaces, select Disable on the Bluetooth param-
eter.
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Chapter 14 Technical specifications
14

This chapter contains the technical specifications of the 6000A V2 Plat-
form.

The topics discussed in this chapter are as follows:

– “Display” on page 126

– “Memory” on page 126

– “Input/Output” on page 126

– “Power supply” on page 127

– “Dimensions - Weight” on page 128

– “Environment” on page 128

– “Characteristics of the options” on page 129
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Display
Display

Screen – Back-light color screen

– Size: 8 inches

– Resolution: 800 x 600 pixels

– Standard high visibility touchscreen

– 2 options are available:

Resistive touchscreen panel (RTP)

Capacitive touchscreen panel (CTP)

Memory
– Standard memory: internal memory, minimum capacity 8 Gbytes (of 

which 128 Mbytes are available for data storage).

– 2 GB Nand Flash (program + storage)

– 64 MB acquisition memory

Input/Output
– Two USB 2.0 Master ports.

– One mini USB 2.0 device

– One RJ 45 connector for Ethernet interface LAN 10/100/1000 Mbit/s

– One RS422 interface (for future use)

– One micro SD interface

– One Audio jack

– Built-in microphone and loudspeaker

– One optical option board (optional)

– Built-in SATA 2"5 Hard Disk (optional)

– Built-in Bluetooth or built-in WIFI (optional)
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Power supply
Power supply

Battery The instrument is supplied with one Lithium Ion battery: 

– a standard Lithium Ion battery with the 6000A V2 Platform and 6100 
module box

– a high power Lithium Ion battery with the 6000A V2 Platform and 
6200 module box

– Reference for the MTS/T-BERD 6000A V2 - 6100: E60LIION/ 
DC 11.1V / 6.6Ah

–  Reference for the MTS/T-BERD 6000A V2- 6200: E60LIHP1 / 
DC 10.8V / 7.2Ah 8A max

Endurance of the 6000A V2 Platform with one standard lithium ion 
battery (ref E60LIION)

Measurement conditions:

- at +25 °C, 

- at nominal capacity (6.6 Ah), 

- 6000A V2 Platform equipped with an OTDR plug-in, type 8126B.

Endurance

– Test carried out in accordance with Telcordia GR-196-CORE 
recommendations: lighter backlight for the screen, (3 acquisitions of 
30s per 15 minutes and auto-off): up to 9 hours.

With continuous acquisition:

– up to 4 hours with normal screen lighting.

Mains adapters
Standard Mains Adapter

Input 100-240 V, 50-60 Hz

Output 19 V continuous,        4.73 A max

Compliance EN 60950
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Dimensions - Weight
Dimensions - Weight

Dimension

– Mainframe with module box type 1 : L x H x W = 290mmx188mmx97 
mm (11.5"x7.4"x3.8" )

Weight

– 2.4 kg (5.3 lbs) without battery nor module.

– 3.4 kg (7.5 lbs) with one module carrier and battery

Environment

Temperature – Operation on mains supply, excluding options:
-20°C to +50°C.

– Operation including all options (guaranteed specifications): 
0° to +40° C

– Storage: -20°C to +60°C

Humidity – 5 to 95% without condensation

EMI/ESD – CE Class A Compliant 

– FCC 47-1 Part 15 Compliant

Drop test In accordance with the Telcordia GR-196-CORE recommendations, the 
6000A V2 Platform resists the following test: 

– 6 impacts dropped from a height of 76 cm (1 impact on each of its 6 
sides, with power off).

Shocks The 6000A V2 Platform resists the following test:

– 3 shocks per axis along each of the 3 axes, with power off.

– Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Class A product: in a domestic environment, this product may cause 
radio interference in which case the user may be required to take ade-
quate measures.
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Bumps The 6000A V2 Platform resists the following test: 

– 1,000 jolts per axis along each of the 3 axes, with power off.

– Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Sinusoidal
vibration

Non Operational mode

The 6000A V2 Platform resists the following vibration tests:

– Complete test comprising 6 cycles along each of the x, y and z axes.

– 3 mm amplitude displacement test, for the range 5 Hz to 22 Hz.

– 3 cycles of 23 Hz to 500 Hz and back to 23 Hz with a 3g accelera-
tion and a sweep rate of one octave/minute.

Operational mode

The 6000A V2 Platform resists the following vibration tests:

– Complete test comprising 2 cycles along each of the x, y and z axes.

– 1 mm amplitude displacement test, for the range 5 Hz to 22 Hz.

– 1 cycle of 23 Hz to 500 Hz and back to 23 Hz with a 3g acceleration 
and a sweep rate of one octave/minute.

Random
vibration

The EUT shall be operational when subjected to random vibration of a 
white power spectral density (PSD) of 0.03 g²/Hz, 30 min per axis at 
frequency range between 10-500 Hz.

Flammability The housing of the 6000A V2 Platform (in ABS, type V0) does not prop-
agate fire.

Characteristics of the options

Power meter Specifications given for 25°C, after 20 minutes stabilization time and after 
zero setting.

– Wavelength range: 800 to 1650 nm in steps of 1 nm

– Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 nm

– Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

– Input power range: -60 dBm to +10 dBm

– Maximum resolution: 0.01 dB / 0.01nW
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– Measurement range:+5 to -50 dBm (-45 dBm from 800 to 1250 nm)

– Linearity within the measurement range: ± 0.2 dB

VFL – Wavelength: 650 nm

– Length of fiber: up to 5 km

– Class 2 laser (standards EN60825-1 and FDA21 CFR Part 
1040.10).

Talkset – Dynamic range: typically 45 dB at 25°C.

– Jack socket for headset

– Laser, typical wavelength 1550 nm, class 1 (EN60825 and FDA21 
CFR Part 1040.10)

Bluetooth and
WIFI

– WIFI: standard IEEE802.11 b/g/n

– Bluetooth Option

– Class 2

– Range: up to 20 meters

– Bluetooth V2.1 + EDR
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15

This chapter shows the references of the options and accessories of the 
6000A V2 Platform.

The topics discussed in this chapter are as follows:

– “References of options for the 6000A V2 Platform mainframe” on 
page 132

– “References of scopes and associated accessories” on page 134

– “References of accessories” on page 134
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References of options for the 6000A V2 Platform mainframe
References of options for the 6000A V2 Platform mainframe2 

2.These options must be ordered together with the instrument.

Platforms References

6000A V2 Platform with high visibility colour touchscreen EM6000AV2M /ETB6000AV2M (US)

6000A V2 Platform with colour touchscreen EM6000AV2S /ETB6000AV2S (US)

Module carriers References

Single Module Carrier for one FO plug-in, with standard Liion bat-
tery and AC/DC adapter/charger (to be configured)

E6100

Single Module Carrier for one FO or Transport plug-in, with High 
Liion battery and AC/DC adapter/charger (to be configured)

E6200

Memory options References

Built-in hard disk option for 6000A V2 Platform (100GB SATA) - 
Required for Transport applications

E60V2HDISK

Adapter/Charger for cigar lighter References

High Power mains adapter/charger for cigar lighter E80lighter

Mains options for MTS/T-BERD 6000A a References

Standard additional AC/DC adapter/charger (US) E90WPWUS

Standard additional AC/DC adapter/charger (Europe) E90WPWE

Standard additional AC/DC adapter/charger (UK) E90WPWUK

Power Meter / VFL / Talkset options References

Talk set option for 6000A V2 Platform E80ETS

Power meter option for 6000A V2 Platform E80EPM

Power meter and VFL option for 6000A V2 Platform E80EPMVFL

Power meter and Talk set for 6000A V2 Platform E80ETSPM

Powermeter, Talk Set and VFL for 6000A V2 Platform E80ETSPMVFL

 Universal connectors for Talkset a Reference

Universal PC connector with FC adapter EUNIPCFC
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Universal PC connector with SC adapter EUNIPCSC

Universal PC connector with ST adapter EUNIPCST

Universal PC connector with DIN adapter EUNIPCDIN

Universal APC connector with FC adapter EUNIAPCFC

Universal APC connector with SC adapter EUNIAPCSC

Universal APC connector with ST adapter EUNIAPCST

Universal APC connector with DIN adapter EUNIAPCDIN

Extra adapter for Talkset b Reference

 Universal FC adapter EUFCAD

 Universal SC adapter EUSCAD

 Universal ST adapter EUSTAD

 Universal DIN adapter EUDINAD

a. At least one connector must be chosen
b. Interchangeable in the field

 Universal connectors for Talkset a Reference

Connector for VFL and power meter References

 Universal push/pull connector/adapter, 2.5 mm fiber EUPP2.5

WIFI and Bluetooth options References

Built-in WIFI option for 6000A V2 Platform E60V2WIFI

Built-in Bluetooth option for 6000A V2 Platform E60V2BLUE

Smart Access Anywhere (Software license) References

Smart Access Anywhere for 6000A V2 Platform - L1: Remote coach-
ing and file transfer for T-BERD/MTS-6000 using Ethernet or WIFI 
hotspot connection

SAA-6KAV2-L1

Smart Access Anywhere for 6000A Platform - L2: Remote coaching 
and file transfer for T-BERD/MTS-6000 using Ethernet, WIFI and 
selected 3g Smartphone (via USB or WIFI)

SAA-6KAV2-L2

SmartFTTA (Software license) References

SMARTFTTA OTDR function for T-BERD/MTS-6000A V2 ESMARTFTTA-6KV2

SMARTFTTA OTDR upgrade option for T-BERD/MTS6000A V2 ESMARTFTTA6KV2U

SmartLink (Software license) References

Smartlink OTDR function for T-BERD/MTS-6000A V2 ESMARTLINK-6KV2
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References of scopes and associated accessories

References of accessories

Smartlink OTDR Upgrade for T-BERD/MTS-6000A V2 ESMARTLK6KV2UPG 

SmartLink (Software license) References

FTTH SLM (Software license) Références

FTTH-SLM OTDR option for T-BERD/MTS 6000A V2 ESMARTFTTH-6KV2

FTTH-SLM OTDR Upgrade for T-BERD/MTS-6000A V2 ESMARTFTTH6KV2U

Optipulses (Software license) Références

Optipulses OTDR option for T-BERD/MTS-6000A V2 EOPTIPLS-6KV2

Optipulses OTDR Upgrade for T-BERD/MTS-6000A V2 EOPTIPLS6KV2UPG

Scope Reference

Digital Videoscope kit including FBP-P5000 probe (USB2.0) in a 
small soft case, and 7 tips in a box (FC, SC, SC-APC, LC, U25M, 
U25MA & U12M)

EDFSCOPE5K

Digital Videoscope kit including FBP-P5000i probe (USB2.0) in a 
small soft case, and 7 tips in a box (FC, SC, SC-APC, LC, U25M, 
U25MA & U12M)

EDFSCOPE5Ki

Carrying case for fiber microscope and accessories EOCIS-SC1

Soft and hard carrying cases Reference

Wrap around carrying case for 6000A V2 Platform ESCASE6KV2

Wrap around Soft Case E40SCASE1

User manual for 6000A V2 Platform platform Reference

User manual for 6000A V2 Platform (French) E6000AV2M01

User manual for 6000A V2 Platform (English) E6000AV2M02

User manual for 6000A V2 Platform (German) E6000AV2M03
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NOTE

The User Manuals for MTS/T-BERD 6000A V2 (Platform & Modules) 
are available in pdf format, into the unit.

The printed versions of the manuals are available on option, in 
French, English and German.
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Chapter 16 Maintenance and 
Troubleshooting
16

This chapter describes how to maintain your unit and identify and correct 
problems related to the 6000A V2 Platform.

The topics discussed in this chapter are as follows:

– “Maintenance procedure” on page 138

– “Recycling Information” on page 154

– “Troubleshooting” on page 154

– “General information on warranty” on page 158
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Maintenance procedure

Maintenance work on this instrument must only be undertaken 
by qualified personnel using suitable equipment.

In most cases, it is advisable to contact the nearest Viavi Service Centre, 
which will undertake the appropriate troubleshooting and repair work.
The performance and technical complexity of the 6000A V2 Platform 
class this instrument in a new generation of equipment, for which Viavi 
has laid down a maintenance policy based on the principle of standard 
module replacement.
In implementation of this policy, we have set up powerful card trouble-
shooting test resources in our factories and a rapid dispatch system 
operating between our factories and branches.
Only by this procedure can the high quality of the instrument continue to 
be ensured after repair work. This procedure also has the advantage of 
reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adop-
tion of the following procedure in the event of a fault, before any other 
steps are taken:

– Verify that the instrument is plugged in.

– Check the connections of any peripheral equipment to the 6000A V2 
Platform.

– If a fault is detected, or in case of doubt, it is advisable to contact the 
nearest Viavi Service Centre, which will undertake the appropriate 
repair work. 

Changing the
module carrier

If the module carrier installed onto the Platform must be changed, 
proceed as follows:

1 Switch off the Platform and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

3 Unscrew the 4 screws on the 4 extremities of the pack module 
installed onto the Platform.

4 Pull the pack gently to remove it from the Platform.

5 Set the new module carrier, making flush the connectors (2a & 2b) 
on both parts and the 4 screws with the 4 holes provided for those 
screws (1a -> 1d).

6 Fix the module tightening the screws.
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Installing the
options

If some options have been ordered after the delivery of the T/BERD-MTS 
6000A V2, they have to be mounted by the customer.

Installing a Hard
disk

If the hard disk is ordered after the delivery of the Platform, it has to be 
inserted into the equipment by the customer.

1 Follow step 1 to step 4 to isolate the base unit from the module.

2 Remove the hard disk cover

3 Insert the hard disk into the location provided for that purpose onto 
the base pack

4 Push gently the hard disk to correctly insert it

5 Set back the cover

Fig. 87 Installing a module

1a
1a 1a

1b

1b

1b2b

2a

Captive screws fixing the module
1a 1a

1a
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6 Set back the module pack onto the base pack

7 If necessary plug the equipment to charge the battery 

8 Switch on the 6000A V2 Platform.

9 Press FILE hard key to display the explorer, with the new drive «hard  
disk» on the left of the screen

If the hard disk has not been detected, turn off the instrument and 
check the installation of the hard disk into the base.

Installing the WIFI
or Bluetooth

option

If the option WIFI or Bluetooth is delivered after the platform delivery, the 
customer needs to install himself the option into the equipment.

1 Proceed as described from step 1 to step 4 in the chapter 
“Changing the module carrier” to remove the pack Base from the 
module.

2 Open the cover of the optical options (see Figure 88 on page 140).

3 Install the option wished, WIFI or Bluetooth, in the connector.

Fig. 88 Location for the hard disk and WIFI/Bluetooth 
options

Hard disk

Cover of the 
Hard disk

Location for WIFI/
Bluetooth  options

Cover of the WIFI/
Bluetooth options
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4 Set back the cover, then the module pack onto the base pack

5 If necessary plug the equipment to charge the battery 

6 Switch on the 6000A V2 Platform.

7 Press HOME hard key to display the Home page and press System 
Settings menu key to display the WIFI/Bluetooth parameters..

If the options have not been detected, turn off the instrument and 
check the installation into the base.

Cleaning

Cleaning plates
and housings

The front and rear plates and the housings may become tarnished with 
handling. To clean them, use only a rag moistened with soapy water.

Never use any product containing acetone, trichloro-ethylene, benzine or 
alcohol, as these will attack the printed markings.

Cleaning the
screen

To clean the screen, use an antistatic product.

Cleaning the
optical cable

connector

– Use a non-linting type of paper, such as Joseph paper, soaked in 
isopropylic alcohol.

– Pay particular attention to the polished face of the fiber, rubbing it in 
a direction perpendicular to the axis of the fiber.

Fig. 89 WIFI / Bluetooth option installation

Bluetooth 
dongleWIFI key
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Cleaning the
optical

connections of the
6000A V2 Platform

– Squirt a highly volatile solvent (such as isopropylic alcohol) into the 
connector.

– Blow out the connector using a clean dry air supply from an aerosol 
can fitted with an extension.

Accessing to
the 6000A V2

Platform
information

On the 6000A V2 Platform, some screens allows to display information 
on different elements of the equipment.

To display the information on the 6000A V2 Platform

1 On the Home page, press About to display the presentation screen 
of the 6000A V2 Platform.

General page The General page is displayed by default, and displays the presentation 
screen, with all the information concerning the software versions, the 
hardware options and the module installed.

This page shows:

– The software version information

– The product contents: base, optical options, battery type, module 
installed and date of calibration for options concerned.

The options set into the 6000A V2 Platform are marked with a green 
tick.

NOTE

If your module has a universal connector, unscrew its adaptor to 
access the ferule.

Fig. 90 General page
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Software options
page

This page allows to visualize the software options available on the 6000A 
V2 Platform.

Services Data page This page allows to display information about the elements inside the 
6000A V2 Platform (CPU, Memory, hardware revision, screen refer-
ence...).

1 Once on the About screen, press Services Data menu key to 
display the list of elements contained on your 6000A V2 Platform.

Accessing to
the 6000A V2

Platform
documentation

All documents necessary for the 6000A V2 Platform use are directly 
available onto the equipment.

To display the list of documents available for 6000A V2 Platform use:

1 Validate the Help icon on the Home page.

2 In the new page, click one link to display the corresponding docu-
ment: User manual, Getting Started Manual, Quick Card...

Fig. 91 Services Data page
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Installing a new
version of the

software

Downloading from
Internet

When the software is obtained from the Internet, it must be saved on a 
storage medium before the software upgrade of the product can be 
carried out. To do this:

1 Open Internet Explorer

2 In Internet Explorer, enter the address: http://www.updatemy-
unit.net

3 Click on the link: «T-BERD®/MTS-6000 and 6000A Platform with 
SN > 10000»

Fig. 92 Help page

When a new software version is loaded, there is a risk of re-initializa-
tion of the internal memory. Before installing the new software, it is 
therefore advisable to save the results in the memory, using the Save 
function called up by the FILE button.

Do not interrupt the installation process, as this could damage the 
instrument.

To avoid any interruption of the installation procedure, the 6000A V2 
Platform must be operating on the mains: if the procedure is started 
while operating on battery, a message indicates that the instrument 
must be connected to the mains.
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4 According to your region, click on the one of the following icon to 
download the archive.

Download from European server

Download from North American server

Download from Singapore server

5 In the new dialog box displayed, click on Save to save the exe file 
on the PC.

6 Once completed, connect the USB memory stick to the PC and 
follow the instructions chapter  “Installation from a USB memory 
stick” on page 147, from step 2.

Installation from
Viavi Server

The update can be performed directly onto the equipment, using the 
Viavi server.

1 Connect the 6000A V2 Platform to a PC via an Ethernet link.

2 On the Home page, press System Settings key to open the 
System Settings page.

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

4 In the Upgrade Server box:

– On the line Address Type, select Viavi Server

The address 6k.updatemyunit.net is automatically displayed.

5 Select if the new release for 6000A V2 Platform must be automati-
cally detected (Enable) or not (Disable). See “Checking new 
upgrade on Viavi Server” on page 148.

6 In the I/O Interfaces box:

– On the line Use proxy, select No, Manual or Auto wether a 
proxy is used or not.

7 Press menu key Exit to return to Home page.

8 Press, in succession the menu keys: Expert Tools > Upgrades > 
Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

9 Click on Continue.

Fig. 93 Configuration of the Viavi Server
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The list of the software versions available on the PC is displayed 
next to the versions installed on the 6000A V2 Platform.

Installation from
another server

Before starting the software upgrade via Ethernet, make sure the IP 
address of the PC server.

The update can be performed directly onto the equipment, using an http 
address.

1 Connect the 6000A V2 Platform to a PC via an Ethernet link.

2 On the Home page, press System Settings key to open the 
System Settings page.

3 In I/O Interfaces, on the line Ethernet, select Mode: Dynamic.

4 In the Upgrade Server box:

– On the line Address Type, select Server Name or IP Address.

– Enter the Server Name (if Server Name has been previously 
selected) or the Server Address (if IP Address has been previ-
ously selected)

5 In the I/O Interfaces box:

– On the line Use proxy, select No, Manual or Auto wether a 
proxy is used or not.

6 Press, in succession, Expert Tools > Upgrades > Software 
Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

7 Click on Continue. 

Fig. 94 List of software versions (current and new)

Software versions 
installed on Platform

Software versions 
available on selected 
media for update
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The list of the software versions available on the PC is displayed 
next to the versions installed on the 6000A V2 Platform (see 
Figure 94 on page 146).

Installation from a
USB memory stick

You must be equipped with a USB memory stick with a minimum 
capacity of 128 Mo.

Before installing the upgrade, you must format the USB memory stick 
(see “Formatting the USB memory stick onto the 6000A V2 Platform” on 
page 155).

1 Once formatted, disconnect the USB memory stick from the 6000A 
V2 Platform using the key Eject USB in the Media Utilities page.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB stick:

a Download and save on your PC the .exe upgrade file that you 
can get from the web (see “Downloading from Internet” on 
page 144).

b Once the transfer is completed, double click on the .exe file: A 
window will appear. Check that the folder is correct i.e. the USB 
memory stick driver is appearing in the line at the bottom of the 
dialog box then press OK. If not, click on the icon  in order to 
select the right USB drive.

c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate proce-
dure, from your PC

5 Insert the memory stick into one of the USB ports on the Platform.

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.

Fig. 95 List of software update
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6 Press the HOME hard key, then successively Expert Tools > 
Upgrades > Software Upgrade > Upgrade from USB.

The message Are you sure? is displayed

7 Click on Confirm. 

The list of the software versions available on the USB stick is 
displayed next to the versions installed on the 6000A V2 Platform 
(see Figure 94 on page 146).

Launching the
upgrade

Whatever is the method selected for upgrade (Server, USB key...) and 
once the list of the software versions available is displayed next to the 
versions installed on the 6000A V2 Platform (see Figure 94 on 
page 146), follow these instructions to launch the upgrade:

1 Click on Show Prev choice or Show Next Choice to display the 
previous and next versions available.

2 Click on Confirm this Choice to start the upgrade of the selected 
software(s). 

or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The 6000A V2 Platform is automatically 
rebooted. Upgrading takes several minutes. Finally, the 6000A V2 
Platform is automatically restarted.

Checking new
upgrade on Viavi

Server

If the Viavi Server is selected for upgrade (see Figure 93 on page 145), 
the parameter Check new release can be defined to automatically 
inform user of a new upgrade available for Platform.

1 In the System Settings screen, select Upgrade parameters

NOTE

A bip is emitted each time the USB memory stick is inserted or 
removed from the USB port.

NOTE

The software versions list does not always appear (cf previous ver-
sions) as well as the Previous / Next Choice buttons and the Con-
firm/Continue key. In this case, the upgrading starts automatically.

During the upgrade, the Testing indicator is lit in red. Do not 
push any button or remove the USB memory stick while the 
indicator is lit. The USB stick can be removed if necessary once 
the Testing indicator is off.
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2 Check the Address Type is set to Viavi Server.

3 Define the parameter Check new release to Enable.

If the parameter is set to Enable, a message displays, at any time, 
when one update is available on server.

4 Press Ok to display the list of software versions available (see 
Figure 94 on page 146) and follow instructions “Launching the 
upgrade” on page 148.

Upgrading from
the boot

This method is used to make a complete reinstallation of the software 
versions.

1 Turn off the 6000A V2 Platform using the ON/OFF button, keeping 
the equipment connected to the mains.

2 Insert the USB stick onto which the software versions are stored into 
one of the USB port of the Platform

3 Press simultaneously SETUP + START/STOP buttons

4 Maintaining the two buttons pressed, press ON button to start the 
6000A V2 Platform.

5 A menu is displayed, then the screen allows to select Upgrade from 
from USB

After a few seconds, a new page displays indicating that to continue 
the reboot, the validation key must be pressed.

Press the hard key  .

The reboot starts automatically.

Fig. 96 Checking new release
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Once the upgrade is completed, the 6000A V2 Platform will auto-
matically turrs on and display the Home page.

Installing
licenses

The menu key Install Option allows to import the licence to get a soft-
ware option.

To import the license, you can either enter manually the licence code, 
given in the license file, (.lic file) or import this file with a USB memory 
stick connected to the 6000A V2 Platform.

Enter Manually the
Licence code

1 In the Home page, click on Expert Tools > Upgrades > Install 
Option > Enter Challenge

The edition keypad is displayed

The Testing indicator will be lit in red during upgrade. Do not 
push any key or remove the USB memory stick until the lit turns 
off.

Fig. 97 Example of a License file (.lic)

Licence Code

It is strongly recommended to perform the installation using the 
importation of Licence via a USB memory stick.
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2 Enter the challenge code of the option, set at the bottom of the file 
(see Figure 97 on page 150),

3 Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . Confirm the reboot 
to restart the Platform.

Import the license
from the USB
memory stick

1 In the Home page, click on Expert Tools > Upgrades > Install 
Option > Import License

If the USB memory stick is not already connected to the Platform, a 
message asking the memory stick insertion is displayed. Confirm it 
once the stick is connected.

2 In the File Explorer, select the USB stick, then the license file (.lic) to 
be imported,

3 Click on Load

4 The challenge codes contained in this file will then be loaded auto-
matically and your software options will be installed.

Fig. 98 Enter the Licence code

The license file can be opened via a word processing software 
such as Word...
The challenge code must be entered exactly as it is in the .lic file, 
paying attention to the lower-case and upper-case letters etc.
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5 At the end of this sequence you will be asked to reboot the unit to 
apply the modifications, pushing the key . 

6 Confirm the reboot 

Locking the
6000A V2
Platform

The 6000A V2 Platform can be locked at any time:

1 In the Home page, press Expert Tools > Instrument Lock Out

2 Confirm the 6000A V2 Platform locking by clicking on Confirm (or 
use the Cancel key to cancel the process).

The numeric keypad is displayed

3 Enter the password to lock the instrument: 42000.

Fig. 99 License imported

Fig. 100 Password
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4 Click on Enter

The 6000A V2 Platform locking screen is displayed.

Click on the Notepad Message key to add a message using the text 
edition.

Unlocking the 6000A V2 Platform

1 Once the locking screen is displayed, click on the key Unlock 
Instrument.

2 Press confirm to confirm the Platform must be unlocked.

3 Enter the password 42000 using the numeric keypad displayed and 
validate.

The screen automatically displays the Home page.

Returning an
instrument

When returning an instrument, it is essential to indicate the following 
minimum information:

– the type and serial number of the instrument (on the identification 
label) and the configuration code (under the bar code)

– a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee
conditions

Any repair operation supervening within the guarantee period of the 
instrument will be carried out at the expense of Viavi. However, for any 
sub-assembly upon which work has been carried out otherwise than by 
Viavi Service Centers, the cost of a replacement sub-assembly will be 
invoiced.

Fig. 101 Locking screen
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Recycling Information
Viavi recommends that customers dispose of their instruments and 
peripherals in an environmentally sound manner. Potential methods 
include reuse of parts or whole products and recycling of products 
components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not 
be disposed of with household waste. Il should be deposited at an appro-
priate facility to enable recovery and recycling.

Troubleshooting

Interpreting
alarms

Troubleshooting Solution

Nothing happens when the ON/
OFF key is pressed.

- Make sure that the battery is present or charged; or the 
mains adapter is properly connected (see  “Connecting 
the mains adapter” on page 14).

Nothing happens on screen, 
whatever is the action done 
(menu key or hard key 
pressed...)

- The Platform must be rebooted.
See “Resetting the 6000A V2 Platform” on page 16.

You are using the 6000A V2 
Platform in the ordinary way 
when it suddenly switches off.

- Check the instrument is not configured to Auto off.
See “Defining the Automatic shutdown of the 6000A V2 
Platform” on page 22. 
- Check the battery charge level.
See “Charging the battery” on page 14.

The battery refuses to charge 
(the Battery indicator does not 
go on when the instrument is 
connected to the mains and is 
not operating).

- There is no battery in the instrument.
- The temperature level of the equipment does not allow 
the battery charging for safety reasons. Wait the equip-
ment cools down.
- The battery needs to be changed.
See “Changing the battery” on page 156.

When using the touchscreen, 
nothing happens

- The touchscreen needs to be calibrate.
See “Touchscreen calibration” on page 156
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Formatting the
USB memory
stick onto the

6000A V2
Platform

If the USB icon  is displayed on the upper banner of the screen, 
when a USB memory stick is connected to the 6000A V2 Platform, this 
may means the memory stick must be formatted.

If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the 
6000A V2 Platform.

2 In the Home page, press successively Expert tools > Media utili-
ties > Usbflash Format.

3 Confirm your choice to actually format the USB memory stick.

Erase disk/
harddisk

To delete all the disk contents of the 6000A V2 Platform:

1 On the Home page, press Expert Tools > Media Utilities, 

2 Select Erase Disk/Erase Harddisk to delete all the disk contents 
into the 6000A V2 Platform.

3 Confirm the deletion clicking on Confirm

Error message when USB has 
been disconencted

- The USB disconnection has not been done properly 
(see “USB memory stick disconnection” on page 89)
- The data transfer was not completed when USB key 
was disconnected.

No beep is emitted when the 
USB memory stick is connected

- A previous USB memory stick has not been properly 
disconnected (see “USB memory stick disconnection” on 
page 89).
- The USB memory stick is not detected by the 6000A 
V2 Platform: use another memory stick, or another stor-
age media; or transfer data via USB cable (see “Trans-
ferring files to/from a PC with a FTP server” on page 78).

Error message when upgrade 
via Ethernet is confirmed

- Check the Server Name is correctly entered (see 
“Installation from another server” on page 146)

Error message when upgrade 
via USB key is confirmed

Check the USB key is correctly connected (see “USB 
memory stick connection” on page 89)

Error message when unlocking 
the instrument

- The password is not the correct one (see “Locking the 
6000A V2 Platform” on page 152).

Troubleshooting Solution

As for any media formatting, please note that all data present on 
the USB memory stick will be irremediably lost.
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4 Enter the password 02468753 and confirm clicking on Enter

A window displays during deletion and once the deletion is 
completed, a message inform you.

5 Press any key to continue.

Touchscreen
calibration

If you meet problems when using the touchscreen (example: pressing on 
an icon does not work correctly...) a calibration can be performed on the 
6000A V2 Platform touchscreen. To calibrate the touchscreen, proceed 
as follows:

1 In the Home page, press System Settings menu key.

2 In the System Settings page, press menu key Touch Screen.

A blue slightly smaller screen appears, displaying a little target on 
the left hand corner. 

3 Click on this target (preferably with the stylus for touchscreen). 

4 A new target appears then and again, for a total of 4 times, in order 
to click on all corners of the screen.

If all the targets are not correctly touched, the touchscreen cannot be 
used. Otherwise, the touchscreen may be used directly.

Changing the
battery

If you meet problems during the Platform functioning, or if the battery 
does not charge anymore when plugged, this may require the battery to 
be replaced

Removing the
damaged battery

To access the battery of the 6000A V2 Platform, proceed as follows

1 Switch off the 6000A V2 Platform and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

Fig. 102 Touchscreen calibration

Target
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3 Slacken the two screws located at the bottom of the instrument 
using a coin, and unscrew them

4 Remove the cover of the battery pack. 

The battery can then be removed, taking care not to damage the 
connectors into which it is plugged.

Setting a new
battery

1 Set the new battery into the housing provided for that purpose, 
taking care not to damage the connector.

2 Press gently but firmly to make sure it is correctly set.

Fig. 103 Battery seatings

Battery

Battery 
housing

Battery Cover

Fig. 104 Battery position

Push toward right
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3 Put back the battery cover and lock the screws.

General information on warranty
The warranties described herein shall apply to all commercially available 
Viavi products. Any additional or different warranties shall apply only if 
agreed to by Viavi in writing. These warranties are not transferable 
without the express written consent of Viavi. 

Hardware
Warranty

Viavi warrants that Hardware Product sold to customer shall, under 
normal use and service, be free from defects in materials and workman-
ship. Information regarding the specific warranty period for this product 
can be obtained by contacting your local Viavi Customer Service Repre-
sentative, or at our web site www.viavisolutions.com. If installation 
services have been ordered, the warranty period shall begin on the 
earlier of (1) completion of installation, or (2) thirty (30) days after ship-
ment to customer. If Installation Services have not been ordered, the 
warranty period shall begin upon shipment to Customer. Hereafter these 
periods of time shall be collectively referred to as the Initial Warranty 
Period.

Viavi ’s obligation and customer’s sole remedy under this Hardware 
Warranty is limited to the repair or replacement, at Acterna’s option, of 
the defective product. Viavi shall have no obligation to remedy any such 
defect if it can be shown: (a) that the Product was altered, repaired, or 
reworked by any party other than Viavi without Viavi’s written consent; 
(b) that such defects were the result of customer’s improper storage, 
mishandling, abuse, or misuse of Product; (c) that such defects were the 
result of customer’s use of Product in conjunction with equipment elec-
tronically or mechanically incompatible or of an inferior quality; or (d) that 
the defect was the result of damage by fire, explosion, power failure, or 
any act of nature.

Viavi performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial 
Warranty Period, whichever is longer. Risk of loss or damage to Product 
returned to Viavi for repair or replacement shall be borne by customer 
until delivery to Viavi.

Upon delivery of such product, Viavi shall assume the risk of loss or 
damage until that time that the product being repaired or replaced is 
returned and delivered to customer. Customer shall pay all transportation 

NOTE

If the battery is not correctly installed, the cover cannot be screwed.
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costs for equipment or software shipped to Viavi for repair or replace-
ment. Viavi shall pay all transportation costs associated with returning 
repaired or replaced product to customer.

Warranty
disclaimer

For hardware and/or services furnished by Viavi, the foregoing warran-
ties are in lieu of all other warrantees and conditions, express or implied. 
Viavi specifically disclaims all other warranties, either express or implied, 
on any hardware, documentation or services including but not limited to 
warranties relating to quality, performance, noninfringement, merchant-
ability or fitness for a particular purpose, as well as those arising from any 
course of dealing, usage or trade practice. under no circumstances will 
Viavi be liable for any indirect or consequential damages related to 
breach of this warranty.
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Appendix A Calibration Recommended
A

The following appendix provides recommended calibration period  for the 
MTS/T-BERD 6000 and MTS/T-BERD 6000A.
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Recommended Calibration Period
Recommended Calibration Period

The calibration interval shall be regarded as a recommendation.
The real definition of the calibration interval should be made by the user. 
The type of application and the environmental conditions should be taken 
into account.

Due date of the calibration certificate shall be calculated accordingly by 
the user.

Mainframe equipped with Power Meter option 12 months

Mainframe equipped with Laser Source option 12 months

Mainframe used with Reflectometer module 12 months

Mainframe used with Fiber Characterization 
module
(CD / PMD / AP)

12 months

Mainframe used with MSAM module
(MTS/T-BERD 6000A only)

36 months
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